# Contents

Section Overview .......................................................................................................................... 1

Getting Started............................................................................................................................. 2

Before you start ............................................................................................................................ 2

About this guide ........................................................................................................................... 2

Intended Audience ....................................................................................................................... 2

Conventions ................................................................................................................................. 2

Notes ............................................................................................................................................ 3

Hardware Requirements ............................................................................................................. 3

Software Requirements .............................................................................................................. 3

BlueBayCT Modes ....................................................................................................................... 4

Inactive Mode ............................................................................................................................... 4

Practice Mode .............................................................................................................................. 4

Patient Mode ............................................................................................................................... 4

Notification Bubbles ................................................................................................................... 5

Downloading Web Files ................................................................................................................ 6

Contract Indicators ....................................................................................................................... 8

Alert Indicators ............................................................................................................................ 8

Using Alert Indicators .................................................................................................................. 8

About the Alert Indicators Screen ............................................................................................... 8

Colour-Coding of Contract Indicators ......................................................................................... 9

Alert Indicators ............................................................................................................................ 11

Toolbar ........................................................................................................................................ 11

Right-Click Menu ........................................................................................................................ 13

Showing or Hiding the Alert Indicators ....................................................................................... 13

Floating Toolbar .......................................................................................................................... 13

Using the Floating Toolbar .......................................................................................................... 13

Floating Toolbar Light Bulb Colouring ....................................................................................... 14

Changing the Appearance of BlueBayCT .................................................................................. 15

Moving the Alert Indicator Window .......................................................................................... 15

Moving the Floating Toolbar ...................................................................................................... 15

Re-sizing the Alert Indicator windows ...................................................................................... 15

Data Entry Tools .......................................................................................................................... 16
Read code Data Entry Screen
Apply Column
Priority Column
Episode Type Column
Date Recorded Column
Read Code Column
Description Column
Value Column
Comments Column
Show More Button
Comments Button
Exception Read codes
Expired Exception Read codes
Entering Additional Codes
Recording Measurements and Values
Recording BMI Values
Recording Blood Pressure Values
Recording Smoking Status
Using the Notes Summary Data Entry Screen
Assessment Forms & Risk Calculators
Questionnaires
ASSIGN CVD Risk Calculator
eGFR Calculator
Framingham CHD / CVD Risk Calculator
JBS 2 CVD Risk Calculator
Peak Expiratory Flow Rate (PEFR)
Spirometry
Add to Register
Extra Indicators
Prevalence Searches
Register Checks
Contract Templates
Opening a Contract Template from the Floating Toolbar ................................................................. 40
Opening a Contract Template from the Notification area on the Taskbar ......................................... 40
Alternative methods of Opening a Contract Template ..................................................................... 41
Using Contract Templates ................................................................................................................. 41
Default Date .................................................................................................................................... 41
History ............................................................................................................................................... 41
Status Bar ......................................................................................................................................... 43
Toolbar ............................................................................................................................................. 43
Contract button ................................................................................................................................ 43
Undo Last Entry ................................................................................................................................. 43
Tabs .................................................................................................................................................. 43
Next Tab and Previous Tab Buttons ................................................................................................... 43
Next and Previous Buttons .................................................................................................................. 43
Viewing Details of Contract Information ........................................................................................... 44

Practice Reports ............................................................................................................................... 46
Accessing the Practice Reports Tools .............................................................................................. 46
Patient Target Lists .......................................................................................................................... 47
Using Patient Target Lists ............................................................................................................... 47
How Patient List Information is calculated ..................................................................................... 48
Working with Data within the Patient Target Lists .......................................................................... 48
Recording Information Using Patient Lists ...................................................................................... 48
Printing a List of Patients on a Patient List ....................................................................................... 48
Looking at Other Indicators for Patients in the Patient Lists ............................................................ 49
Opening a Patients notes from the Patient List ............................................................................... 49
Producing Recall Letters Using Mail Merge Tools .......................................................................... 49
Designing Patient Recall Letter Templates .................................................................................... 49
Create a New Recall Letter Template ............................................................................................... 50
Edit or Delete Letter Templates ........................................................................................................ 51
Important Information about Letter Templates ................................................................................ 52
Running a Mail Merge from Patient Target Lists ............................................................................. 52
Multi-Disease Registers .................................................................................................................... 53
Managing the Recall Status using Letter Levels .............................................................................. 54
Targeting High-Value Patients for Recall ................................................................. 55
Recalling Patients by Phone .................................................................................. 56
Adding Codes to Multiple Patient Records ........................................................ 56
Read code Data Entry Screen for Non-Contract codes ........................................ 57
Server Login Details button .................................................................................. 59
Synchronise button ............................................................................................... 59
Last Run button .................................................................................................... 59
High Value Patients ............................................................................................... 59
Contract Manager .................................................................................................. 61
The Contract Manager Screen ............................................................................... 61
Updating Contract Manager .................................................................................. 62
Navigating Through the Different Contract Domains ............................................. 62
Working with Data on the Contract Manager Screen ............................................. 63
Entering Manual Point Information ..................................................................... 64
Adjusting Point Aspirations ................................................................................... 65
Opting out of Clinical Categories .......................................................................... 65
Specifying Payment and Prevalence Information ................................................... 66
Generating a Points Report from Contract Manager .............................................. 67
Generating a Percentage Report from Contract Manager ..................................... 68
Updating and Displaying Yearly Results ............................................................... 69
Printing Information on the Contract Manager Screen .......................................... 70
Exporting Information to a CSV File .................................................................... 70
Shrinking / Enlarging the graphs .......................................................................... 70
Data Extract ........................................................................................................... 71
Configuration & Settings ....................................................................................... 73
Using the Settings Screen ...................................................................................... 73
Options Tab ............................................................................................................ 73
Forward Dating Tab .............................................................................................. 75
Advanced Tab ........................................................................................................ 76
Scheduler Tab ........................................................................................................ 77
Order Tab ............................................................................................................... 78
Protocols Tab ........................................................................................................ 79
Indicator Logic Tool.............................................................................................................................................. 104
Rule Logic Tool .................................................................................................................................................. 106
Rule Logic Exception Tool ............................................................................................................................... 107
Troubleshooting................................................................................................................................................. 108
Section Overview

This guide is divided into the following sections:-

- **'Getting Started'**, outlines the basic hardware and software requirements. It describes the BlueBayCT modes and details how to download additional BlueBayCT web files that are available to the practice. Additional web files that can be downloaded include such areas as seasonal flu, maternity record and lab results summary. Instructions on how to carry out a BlueBayCT server upgrade is also given, although your practice may have this done for you depending on your location.

- **'Contract Indicators'**, details how the 'real-time' Contract Indicators can help you make sure that you are providing appropriate levels of care during the clinical consultation. All of the indicators are based on the approved specification issued by the Department of Health.

- **'Data Entry Tools'**, explains how to make best use of the data entry screens which is a pivotal part of the software. You'll find out how to quickly and efficiently enter data based on Read codes and drug information, as well as being able to input measurements and values.

- **'Contract Templates'**, helps you to get the most from using the default contract templates.

- **'Practice Reports'**, deals with the report tools included within the software. Running patient target lists, calling in patients by letter or phone using the mail merge tools. Also explained is Contract Manager which is used to monitor your points and targets of the practice as a whole. In addition the individual clinician's contribution to each of the contract areas can be viewed.

- **'Configuration & Settings'**, looks at the different setup options that are available to you. You can also find out how to schedule some of the administration tools to run automatically when you are away from the computer.

- **'Creating and Modifying Contract Templates'**, explains how the practice can 'customise' the existing templates or create your own templates from scratch. These templates will help you to collect patient data in a concise and consistent manner and can help nurses and healthcare specialists to run clinics or record data for screening procedures.

- **'Logic Tools'**, introduces the BlueBayCT Logic Tools available to help understand the more complicated rules and logic. Three Logic Tools are available. The Indicator Logic tool is available for all Indicators and provides an in-depth solution for analysing the Ruleset behind the registers and indicators. The Rule Logic and Rule Logic Exception tools help the user by visually displaying what needs to be done in order for the Indicator to be fulfilled and hence cancelled (only applicable to the more complicated Indicators).

- **'Troubleshooting'**, provides answers to common problems that you may come across.
Getting Started

Before you start
This Complete User Guide is in PDF format and is best viewed using Adobe Reader X version 10.1.1 or above. Please click here to download the most recent version of Adobe Reader X.

About this guide
Welcome to the Complete User Guide for BlueBayCT. This guide can be printed out in its entirety or the relevant sections can be directly accessed by clicking on the help icon from within BlueBayCT.

Embedded within this User Guide are Hyperlinks, which are blue and look like this, and will take you to the topic relevant area within this User Guide.

Intended Audience
This guide was developed to provide practice staff and supporting IT associates with all the reference material they need to install, configure and get the most out of using the software.

Conventions
The following conventions are used throughout this guide:-

Notational Conventions

• The term “Click” is used throughout this document to describe the pressing of the left-hand mouse button. The term “Right-click” is used to describe the pressing of the right mouse button, which commonly displays a menu.

• Names of files and folders appear in TITLE CAPS, except when you are to type them directly. Unless otherwise indicated, you can use all lowercase letters when you type a file name in a dialog box or at a command prompt.

• File name extensions appear in lowercase.

• Acronyms appear in UPPERCASE.

Diagrams & Illustrations

• All illustrations and example screens, including images of buttons or screen areas have been captured from a Windows XP Professional operating system. There may be slight differences between screens on older operating systems. All screens are produced using the standard Office Silver theme. If you have changed the theme in Configurations and Settings – Advanced Tab then they will look slightly different but the functionality will remain the same.
Notes
Several types of Notes appear throughout this guide:-

- **Tips** contain explanations of possible results or alternative methods.
- **Notes** contain supplemental information.
- **Cautions** contain warnings about possible errors or problems.

Hardware Requirements
To run the software each computer on the network must have the following minimum configuration:-

- 256 megabytes (MB) of RAM.
- At least 40 megabytes (MB) of available disk space on the practice server drive.
- 30 megabytes (MB) of available disk space on the local drive.
- Intel Pentium II or compatible at 500 megahertz (MHz) or faster.
- Mouse or compatible pointing device.
- VGA-compatible display adapter.

Software Requirements
The following software is required to complete the installation:-

- Microsoft Windows NT4 Workstation, Windows 2000 Professional, or Windows XP Professional operating system on the client workstations.
- Secure Internet access to the World Wide Web (WWW). Ideally on both the server and workstation clients.
- Microsoft Data Access Components (MDAC) version 2.8 or above installed on practice server and client workstations. MDAC is not required on clients running Windows XP or later.
BlueBayCT Modes

BlueBayCT has three modes of operation available to the user and the functionality of BlueBayCT depends on the mode that is currently selected. The different modes are automatically selected and displayed depending on whether you are logged into your clinical system and whether a patient’s clinical notes are currently open. The menu is accessed by a right-click with the mouse on the Light Bulb icon (💡) shown in the notification area of the windows taskbar. The three modes are:

Inactive Mode
If your Clinical System is not currently running Inactive Mode is automatically selected, indicated by the red bar. All the menu items except ‘Help’ will be greyed out.

Practice Mode
If your Clinical System is currently running but you are not in a patient’s clinical notes then Practice Mode is automatically selected, indicated by a blue bar. Functions available in this mode are generally administration functions that affect the whole practice.

Patient Mode
If your Clinical System is currently running and you are in a patient’s clinical notes then Patient Mode is automatically selected, indicated by a green bar. Functions available in this mode are specific to the current patient.
Notification Bubbles

The software alerts the user to important changes to the software via a notification bubble which appears from the Light Bulb icon in the Notification area of the Windows Taskbar.

Can't connect to the internet to check your licence, XX day(s) remaining.

This message is displayed when an individual client machine cannot make contact with the licensing server to validate the licence. It does not mean that the client does not have a licence. Possible reasons for this message include lack of internet connection, blocking of connection by a Firewall or Virus Protection package, or the use of a proxy server. The client will continue to work for 31 days without validating the licence. After 31 days the software will cease to work and a message will be displayed to this effect.

Template updates are available, please goto Download Web Files.

This message is displayed when a new version of a previously Downloaded Web File is available. The message will be displayed until the new version is downloaded from Download Web Files. To learn more about downloading web files, see Downloading Web Files.
Version XX.X is available, please run Server Upgrade.

This message will appear when a new version of the software is available to download. This will be carried out by the support desk.

**Downloading Web Files**

BlueBayCT has access to a number of additional templates that can be used to improve patient care, creating a single template that holds all the relevant information and will also allow the user to input information from the template. These templates are similar to the QOF templates, but contain non-QOF information such as NICE guidelines and Local Enhanced Services. It is up to the practice to download the ones that they choose to use. Web Files can be downloaded and managed from the Download Web Files screen.
To Download Web Files, use the following method when in Practice Mode:-

1. Right-click the Light Bulb program icon (💡) in the Notification area of your Windows Taskbar.

2. From the pop-up menu, select Download Web Files.

3. Click to place a Tick in the Download column for the template you wish to download.

4. Click on the Download button on the Toolbar.

5. A splash screen will appear showing the progress of the download.

Templates that have been downloaded by the practice are available to all users providing that Disable User Defined Indicators is not checked in Configuration and Settings.

The status column quickly shows which templates have already been downloaded to the system, and which templates have a new version that may be downloaded. Template Version numbers can be compared between the Web Version and Local Version to see if a more recent version is available for download from the web. To remove a template from the system simply click to place a Tick in the Delete column alongside all the templates you wish to remove, then select Delete from the Toolbar.
Contract Indicators

Alert Indicators
In today’s busy medical practice, it is important to have up-to-the-minute, accessible information on patient care at the point where you need it most – during consultation. These contract tools are unique in that they are based on 'live data' and the Alert Indicators are no exception to this rule.

During the consultation, the patient record is analysed and an appropriate set of alerts for the patient is generated. You can use your clinical system's own consultation screens to input the data, or you can use these easy-to-use data entry screens (see Data Entry Tools). As you begin recording data in the patient record, the software will quickly examine what you have recorded and update the list of alerts appropriately and in real-time.

Using Alert Indicators
The Alert Indicators screen displays a list of items that need to be recorded for the patient. The wording for the description of each indicator is taken from the Department of Health, health care protocol, or clinical guideline specifications. Each set of indicators is grouped into QOF, Enhanced Services, NICE guidelines, SIGN guidelines, and Other indicators. You can use the floating toolbar at the top of the screen to switch between the different groups, or you can combine these using the Settings screen. A useful toolbar at the top of the window provides quick access to additional features and screens for each indicator that you click on.

If you prefer, you can also right-click with the mouse on each indicator alert and choose these functions from a pop-up menu. When the contract indicators are first displayed, all categories are 'expanded' by default to show the indicators within them, with the exception of categories that do not have any outstanding indicators which are shown in green. If you want to show or hide the indicators within the different categories, click the Expand (♭) or Collapse (▼) buttons.

About the Alert Indicators Screen
The Figure below shows the different elements of the Indicator alerts screen. The screen always stays on top of the consultation screen but if closed, by clicking close (🗖), can be brought back up again through the floating toolbar. The reference date for forward dating is always shown at the top of the indicators box, along with the patient's name.
Colour-Coding of Contract Indicators

BlueBayCT helps you to identify the time constraints for registers and indicators that you need to complete, through the use of colours. If you have changed any settings on the Forward Dating tab in the Settings screen, future information is displayed in addition to the indicators that you can currently record.

The following colour-coding conventions are used to show contract information:-

<table>
<thead>
<tr>
<th>Colour</th>
<th>Type of Indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black Text</td>
<td>Information that requires completion now. Following the QOF business rule set, these are either outside of the time constraints, or have never been recorded.</td>
</tr>
<tr>
<td><strong>Bold Blue Text</strong></td>
<td>Information has already been recorded within the specific time constraint, but will fall outside of the time constraint at the specified reference date, e.g. April 2013. If data is recorded now, they will be removed from the list.</td>
</tr>
<tr>
<td>Blue Text</td>
<td>Information that cannot be recorded until specific criteria is met, e.g. within a set period for the year, or if a specific age is reached within the year. These indicators are for information purposes and are not removed if data is recorded when outside the criteria.</td>
</tr>
<tr>
<td><strong>Bold Green Text</strong></td>
<td>A Category where there are no current outstanding indicators. Within a template where an indicator has been completed.</td>
</tr>
<tr>
<td>Bold Grey Text</td>
<td>Information that does not currently apply to the patient, e.g. where a patient is not part of a register.</td>
</tr>
<tr>
<td><strong>Bold Red Text &amp; Red Flag</strong></td>
<td>A Category has been exception coded.</td>
</tr>
<tr>
<td><strong>Orange Flag</strong></td>
<td>A Category/Indicator where a previous exception code has expired.</td>
</tr>
</tbody>
</table>
Shown Below is an illustrated overview of the Colour-Coding conventions:

Colours and text meanings:
- **Indicators in Bold Blue Text** mean that information has already been recorded but will fall outside of the time constraint and need to be recorded again to count.
- **Indicators in Black Text** mean that they require completion now.
- **Categories in Green Text** mean that they have been completed i.e. There are no outstanding indicators.
- **Categories in Red Text** mean it has been exception coded. It is also displayed with a red flag.
- **Categories in light blue Text** mean that information recorded will not count towards the QOF as a specific time criteria has not been met. The Indicator is not removed as the data recorded will be outside the criteria. (They are for information only and when the time criteria is current they change to Black Text indicators).

The colour coding detailed above is dependent on which settings are selected in the Forward Dating Tab in Settings. This Colour Coding of Contract Indicators keeps you informed of time constraints. More information and instructions on how to change the forward dating can be found in Configuration & Settings.
**Alert Indicators**

The main area of the screen shows the Contract Indicators that are outstanding. The Contract indicators are grouped below their relevant category headings which are shown on a white coloured line with either an **Expand (►)** or **Collapse (▼)** button alongside.

Double clicking on the Indicator causes the default data entry screen to load. This is the same as selecting it from the toolbar, or from the menu displayed when right-clicking on the Contract Indicator.

---

**When the contract indicators are first displayed, all categories are 'expanded' by default to show the indicators within them. If you want to show or hide the indicators within the different categories, click the Expand (►) or Collapse buttons (▼).**

---

**Toolbar**

The Toolbar is located along the top of the screen and is used to access the various functions e.g. contract codes, exception codes, depression questionnaire, BP measurements, etc. By clicking on and highlighting the Indicators the relevant buttons on the toolbar become enabled or disabled depending on whether they are available for use. By double clicking on an individual Indicator in the list the default toolbar button is automatically activated. Shown below are some of the main tools but other tools are used. Hover the cursor over the toolbar for a description of what each button does.
<table>
<thead>
<tr>
<th>Tool Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Displays Read code Data Entry Screen to enter Contract Read codes</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Displays Contract Template of the currently highlighted category</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Displays Indicator Logic screen of the highlighted indicator</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Displays Smoking Data Entry Screen</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>Refreshes the Alert Indicators</td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
<td>Displays Rule Logic screen for the highlighted indicator</td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>Displays BMI Data Entry Screen</td>
</tr>
<tr>
<td><img src="image8" alt="Icon" /></td>
<td>Displays Read code Data Entry screen to enter Exception Read codes</td>
</tr>
<tr>
<td><img src="image9" alt="Icon" /></td>
<td>Displays Read code Data Entry screen to enter Expiring Exception Read codes</td>
</tr>
<tr>
<td><img src="image10" alt="Icon" /></td>
<td>Displays Read code Data Entry screen to enter Additional Read codes</td>
</tr>
<tr>
<td><img src="image11" alt="Icon" /></td>
<td>Displays Blood Pressure Data Entry Screen</td>
</tr>
<tr>
<td><img src="image12" alt="Icon" /></td>
<td>Displays Rule Logic Exception screen for highlighted indicator</td>
</tr>
<tr>
<td><img src="image13" alt="Icon" /></td>
<td>Displays the Depression Questionnaire</td>
</tr>
<tr>
<td><img src="image14" alt="Icon" /></td>
<td>Displays Notes Summary Data Entry Screen</td>
</tr>
<tr>
<td><img src="image15" alt="Icon" /></td>
<td>Print Previews the Contract Indicators displayed</td>
</tr>
<tr>
<td><img src="image16" alt="Icon" /></td>
<td>Prints the Contract Indicators displayed</td>
</tr>
</tbody>
</table>

*If you are unsure of the functionality of a button within BlueBayCT, then hovering the cursor over a button will provide a Screen Tip which is a description of what the button does.*
Right-Click Menu
By clicking on a Contract Indicator with the Right Mouse Button, a Menu appears showing the options available to for that Contract Indicator. The menu is essentially the same as that shown in the toolbar.

Showing or Hiding the Alert Indicators
At times, you may want to hide the Alert Indicators box if you feel it is a little intrusive. You can easily hide the screen by clicking the Close button (×) on the window. The screen will remain hidden until you open another patient clinical record.

If you want to show the Contract Indicators again for the current patient click on Show QOF Indicators on the floating toolbar.

Floating Toolbar
The floating toolbar is a small toolbar with buttons for each alert group. The floating toolbar will appear to 'hover' on top of your clinical system's consultation screen and all other programs. Because it is much smaller than the Alert Indicators screen, the floating toolbar is less intrusive. The floating toolbar will always be present when you are in Patient Mode.

Using the Floating Toolbar
If you find that you are regularly hiding the Alert Indicators then you may prefer to stop it appearing when you open the patient record, and use the floating toolbar to bring it up when you are ready. The floating toolbar is always present, and by selecting Disable Auto Popup in the Settings screen, the Alert Indicators will not automatically come up when you enter a patient’s record.

The floating toolbar is made up of one or more buttons within it. The buttons displayed depend on your current settings, the additional modules you have downloaded into your system and the information held within the patient record.

The table below describes each of the buttons:-

---

**Show QOF Indicators**
<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Button Icon" /></td>
<td>Displays BlueBayCT Main Menu in the same way the right-clicking the Light Bulb located in the notification area of the Windows Taskbar</td>
</tr>
<tr>
<td><img src="Image" alt="Button Icon" /></td>
<td>Displays QOF Alert Indicator screen</td>
</tr>
<tr>
<td><img src="Image" alt="Button Icon" /></td>
<td>Displays Enhanced Services Alert Indicator screen</td>
</tr>
<tr>
<td><img src="Image" alt="Button Icon" /></td>
<td>Displays SIGN Guidelines Alert Indicator screen</td>
</tr>
<tr>
<td><img src="Image" alt="Button Icon" /></td>
<td>Displays NICE Guidelines Alert Indicator screen</td>
</tr>
<tr>
<td><img src="Image" alt="Button Icon" /></td>
<td>Displays Alert Indicator screen for any Other Indicators</td>
</tr>
<tr>
<td><img src="Image" alt="Button Icon" /></td>
<td>Displays ALL Indicators combined onto one button to reduce the space taken up. This option is activated through the <strong>Combine Triggers</strong> option in the <strong>Settings screen</strong></td>
</tr>
</tbody>
</table>

---

**Floating Toolbar Light Bulb Colouring**

The colour of the light bulb on the floating toolbar is either White or Yellow. The colour depends on if the patient is on any of the QOF registers. The colour of the light bulb also applies to the BlueBayCT light bulb icon in the notification area of the screen.

<table>
<thead>
<tr>
<th>Light bulb Colour</th>
<th>Meaning</th>
<th>Floating Toolbar</th>
<th>Light bulb in Notification area</th>
</tr>
</thead>
<tbody>
<tr>
<td>WHITE</td>
<td>Patient not on any QOF registers</td>
<td><img src="Image" alt="Floating Toolbar Icon" /></td>
<td><img src="Image" alt="Notification Area Icon" /></td>
</tr>
<tr>
<td>YELLOW</td>
<td>Patient on one or more QOF registers</td>
<td><img src="Image" alt="Floating Toolbar Icon" /></td>
<td><img src="Image" alt="Notification Area Icon" /></td>
</tr>
</tbody>
</table>

If your Practice does not have any of the above functions on the floating toolbar then please give us a call to find out what additional features BlueBayCT can offer and how they can help improve your practice.
Changing the Appearance of BlueBayCT

Because BlueBayCT is designed to work with many different screens within your Clinical System, you can change the appearance to your preference. For example, you may want to re-position the alert list so that they do not obscure part of the main consultation screen, or you feel that the list is too small or too large.

The software allows you to 'customise' the layout and appearance of the Alert Indicators and Contract Indicators screen to suit the way you work. It will even remember your preferences so that you don’t have to keep changing the appearance each time you use it.

Moving the Alert Indicator Window

By default, the Alert Indicators will appear in the bottom right-hand corner of your screen, near the Light Bulb icon in the Notification area of your Windows Taskbar. Depending on which screen you use to consult with, you will most likely find it far easier to use if it is displayed in a different part of the screen.

To move to another part of the screen, simply move the mouse pointer over the title bar, click and hold with the left mouse button and drag to the preferred position on your screen. Release the mouse button to 'drop' the box into position.

Moving the Floating Toolbar

In the same way that the Alert Indicator Window can be repositioned, the floating toolbar can be moved if it obscures any important information or buttons behind it.

To move the floating toolbar to another part of the screen, simply move the mouse pointer over the title bar (see image below), click and hold with the left mouse button and drag to the preferred position on your screen. Release the mouse button to 'drop' the floating toolbar into position.

Re-sizing the Alert Indicator windows

Sometimes, the default size may not be suitable to display the whole list of indicators for some of your patients. It might be more helpful if you re-size the Contract Indicators box. To re-size the Alert Indicators, move your mouse pointer over the border of the box. The mouse pointer will change to a 'Resize' cursor.

Click and hold with the left mouse button and drag the border until you are happy with the preferred size. Release the mouse button to keep the new size.
Data Entry Tools

One of the major features of the software is the ability to record key items of information quickly and efficiently using intuitive data entry screens. These same data entry screens are commonly used throughout the software.

From a few simple mouse clicks, you can record any item of data that is relevant and because the software is fully-accredited for use with your clinical system, you can be sure that any information that you record is updating your system in the correct way.

Read code Data Entry Screen

Probably the most commonly used data entry screen is for entering Read codes. The Read code data entry screen can be used to enter many different codes. If the data is altered in any of the rows then an automatic tick is placed in the Apply column.

You can access the Read code Data Entry Screen by clicking on the relevant line to highlight it and then clicking the Contract button ( ) on the toolbar, or simply by right-clicking on the relevant line and selecting it from there.

The Figure below details the different elements of the Read code Data Entry Screen. In addition you may need to Record Information using the Drug Code Data Entry Screen.
**Apply Column**
Under the Apply column, click to place a check in the box of the codes you want to use.

**Priority Column**
Click the cell in the Priority column and a drop down menu button (▼) will appear. When clicked on, a drop down list appears where the priority can set from 1 - 9.

**Episode Type Column**
Click the cell in the Episode Type column and a drop down menu button (▼) will appear. When clicked on, a drop down list appears, and an Episode Type can be selected. By default the Episode Type is blank.

When adding some Diagnosis Read codes e.g. Depression, it is necessary to select an episode type, otherwise the patient will not be correctly placed on the Depression register. This is due to the rules looking for a first episode type.

**Date Recorded Column**
If you want to backdate the code, enter a different date in the Date Recorded column. You can either type the date, or pick a date from the date picker, which is displayed when the drop down menu button (▼) is clicked on.

**Read Code Column**
The Read code column displays the Read code that will be used. It is for information only and cannot be changed.

**Description Column**
The Description column is a description of the Read code that will be used. It is for information only and cannot be changed.

**Value Column**
The Value column is used to record values such as cholesterol, HBA1c levels, etc. DO NOT record these values in the Comments column. By recording the result values in this column it will ensure that the information will be picked up correctly by your clinical system.
Comments Column
Optional free text can be recorded against the selected Read code in the Comments column. A list of predefined Comments can be accessed by clicking on the cell and selecting the drop down menu button (▼). Do not record values in the Comments column; instead they should be stored in the Value column. An alternative method for selecting the Comments you want to enter from the drop down box is to start typing the comment into the Comments box. With each letter entered the software will try to match what is being typed with the Comments already stored.

Show More Button
Because the list of Read codes you can choose from can be quite exhaustive, the software helps with data entry by displaying only the most commonly used Contract Read codes first. Whenever there is a much larger list of Read codes that can be selected, the Read code data entry screens will provide a Show More button ( ▶ Show More ) on the Toolbar for you to expand the available selection.

Comments Button
If you want to add, change or delete any drop down entries in the Comments column, you can click on Comments button on the toolbar. This will open up a simple text file within the Fileshare area of your practice file server. Comments can be added and amended in the text file as necessary. Comments should be entered with one Comment per line. Pressing Return will move the cursor down to the next line before any additional Comments are added. Changes to the text file are saved by clicking the OK button. Changes you make to the text file will not affect the data that you have previously saved.

Exception Read codes
Exception codes can be used when you want to exclude a patient from your audit score; usually because the patient is non-cooperative or because of some other reason that you are unable to record a Contract code. You can enter an Exception Read code by clicking on the relevant line to highlight it and clicking on Show Exception Codes button ( □ Show Exception ) on the Alert Indicator toolbar, or simply by right-clicking on the relevant line and selecting it from there.

In addition to being Exception Read coded from a particular Contract Indicator, a patient can be excepted from a whole category by selecting the Category Heading and clicking on the Show Exception Codes as detailed above.

An example Exception Codes data entry screen for the diabetes register is shown below.
Expired Exception Read codes

The majority of Exception Read codes that you use will have to be recorded regularly, i.e. every 12 or 15 months. The software helps keep you informed of these previously entered Exception Read codes by displaying an orange flag icon (▼) against indicators that you previously exception-coded as shown below.

You can conveniently record the same exception code again for these indicators by clicking the orange flag icon (▼) on the toolbar. If you move your mouse pointer over the button, it will tell you the exception code that you used previously with the date. Where a patient has been exception-coded from a whole category the category title also appears in Orange.
# Entering Additional Codes

Additional Codes (тик) are used to help the practice monitor their patient annual reviews. The software generates this list of codes based on feedback from customers. They are displayed on the **Extra Indicators** template. To access the **Extra Indicators** template click on the light bulb on the floating toolbar and select **QOF Templates**. **Extra Indicators** can then be found at the bottom of the list.

An example Additional codes screen for Hypertension monitoring is shown below.

---

**Important:** Additional codes are only used internally by the practice to improve patient care, and **DO NOT** count towards your final audit score for the new GMS Contract.
Recording Measurements and Values
To help with the recording of data, BlueBayCT has some additional screens that make it easy to record everyday information such as Blood Pressure and BMI as well as various calculators. These user friendly screens simply require the values to be entered and the software will automatically add the appropriate Read codes for you.

Recording BMI Values
The BMI Data Entry screen is used to quickly input the height and weight values and the software will then calculate the BMI for you and post the appropriate Read code into the patient record.

To record BMI using the Body Mass Index data entry screen, use the following steps:

1. Toggle between Metric and Imperial to select the required units.
2. Type in the Height values (or use the up and down arrows).
3. Type in the Weight values.
   (Once the height and weight values are entered the BMI value is calculated automatically)
4. If you want to backdate the reading, change the Applied Date.
5. If you want to use a different Read code from the default of 22K.. Body Mass Index, then select it from the list.
6. Click OK.
Recording Blood Pressure Values
The BP Data Entry screen can be used to quickly record the blood pressure value.

To record a blood pressure value using the Blood Pressure data entry screen, use the following steps:-

1. Type the **systolic** and **diastolic** readings into the BP boxes.
2. If you want to backdate the reading, change the **Applied Date**.
3. Click **OK**.

Recording Smoking Status
The Smoking Data Entry Screen can be used to quickly record the patients current smoking status, including the amount smoked per day and any cessation advice offered.

Using the Notes Summary Data Entry Screen
The software includes a unique data entry screen to help with the summarisation of medical records. Using the Notes Summary Data Entry screen, you can quickly summarise important medical conditions and get your new patients on the clinical registers. The screen also allows you to enter important information such as BMI and blood pressure measurements, whilst at the same time completing the relevant indicators.
The Notes Summary data entry screen is split into two pages:

**Indicators screen**
The first page, Indicators, lets you specify readings and measurements, along with being able to choose which Read code you want to use to indicate that you have summarised the clinical record.

You can use the drop down button to see a history summary of any previous readings that have been recorded. If you want to enter a new measurement value, click one of the buttons to open the relevant Data Entry screen.

**Registers screen**
The second page, Registers, can be used to quickly add Read codes to the new patient clinical record and include the patient in your GMS Contract registers.
When you have finished summarising the patient clinical record, click **OK**.
Assessment Forms & Risk Calculators

BlueBayCT has additional tools and utilities which make it even more useful when capturing data for the contract as well as forms and calculators that help your practice improve patient care. These forms and calculators are extremely intuitive and reduce the clinicians workload by simplifying the process. They can be accessed by clicking on the Calculators menu on the main BlueBayCT menu, and selecting from the relevant group.

The calculators are divided up and split into five categories so the correct calculator can be quickly located.

Questionnaires

Many questionnaires are available to help the clinician assess the patient in various areas. The answers provided by the patient allow the clinician to quantify and scale severity, and then add the result along with the relevant Read code onto the patients record. The questionnaires all work in the same way, following a published algorithm to convert the answers given into a score. The Clinician can either turn the computer monitor to face the patient and allow them to make their own selections, or the clinician can ask the patient and record the answers given.

Questionnaires currently available are Asthma Control Test (ACT), Alcohol Use Disorders Identification Test (AUDIT), Depression, Fast Alcohol Screening Tool (FAST), General Health Questionnaire (GHQ12), Mini Mental Health State, RCP3 Asthma Assessment, COPD Assessment Test (CAT), CHADS2 score for Atrial Fibrillation Stroke Risk and Smoking Pack Years.

Shown below is the Alcohol Use Disorders Identification Test (AUDIT) Questionnaire.
To use the Questionnaires, do the following:

1. Work through the questions with the patient by clicking on the relevant answers.
2. When each page has been completed, click on the next page via the Pages Tabs.
3. When all the questions have been answered, the calculated score is supplied in the bottom right-hand corner of the screen.
4. Select the Read code to be entered into the patient's record from the Read code drop down menu (the calculated score is added onto the Read code selected).
5. If you want to backdate the reading, change the Applied Date.
6. If you want to add a priority, then select it from the Priority Drop Down Box.
7. Click on **OK** to save the Read code and Risk percentage.

**ASSIGN CVD Risk Calculator**

The ASSIGN CVD Risk Calculator can identify people free of cardiovascular disease most likely to develop it over ten years. 'High risk' (score 20 or more) implies it necessary for risk-lowering medication and/or other medical help. ASSIGN is the cardiovascular risk score chosen for use by SIGN (Scottish Intercollegiate Guidelines Network) and Scottish Government Health Directorates. The ASSIGN Calculator screen will appear, as shown below.

In order for the risk to be assessed, the calculator needs information on blood pressure, cholesterol, and the number of cigarettes smoked per day. Without this information the calculator cannot work out the risk. If one or more of these pieces of data are not available then clicking on the relevant Mean button will...
use the Average results for the patient’s age and sex as defined by ASSIGN (these values are NOT recorded within the patient record).

To use the SIGN CVD Risk Calculator, do the following:-

1. Missing patient data can be entered or updated by clicking on the relevant Add Data Button (.addButton) towards the bottom of the screen. If the data is not available then the relevant Mean button can be used instead. The most recent data entry is shown in the History column. Historical data other than the most recent can be viewed by clicking on the History Drop Down button (dropdown).

2. If relevant tick the Family History of Stroke/CHD and/or the patient has Diabetes boxes and the risk score will be amended as per the ASSIGN algorithm (If the patient has Diabetes recorded within the notes then this Diabetes box will automatically be ticked).

3. When all the data is entered the risk in 10 years is displayed along with the relevant Read code.

4. Click on OK to save the Read code and Risk percentage.

A copy of the current screen view can be printed by clicking on the Print Screen button (button). This is useful for placing a copy in the patient’s notes, giving to the patient or even to forward with referrals.

eGFR Calculator
The eGFR Calculator is a tool used to measure kidney function, and is part of the Chronic Kidney Disease requirements. The calculator incorporates two different protocols and you can use either method.

The Sex, Age and any previously recorded Creatinine levels for the patient are displayed (you can also type in the Creatinine result, but this is NOT recorded within the patient record). You can then choose the Equation type – either Abbreviated MDRD or Cockcroft and Gault. If you choose the former type, you will need to specify the Race of the patient.
If you choose the latter Equation type, the eGFR Calculator screen will change to the one below.

Abbreviated MDRD equation requires user to select race

Result Box - The calculated eGFR value and recommended CKD stage are displayed
The Cockcroft and Gault Equation uses the patient’s Weight as part of the calculation and this is picked up from previously entered data (you can also type in the weight measurement, but this is NOT recorded within the patient record).

The eGFR value and recommended CKD Stage is displayed in the Result box.

1. Do one of the following:
   a) Click the More button (●●●) to choose an appropriate Read code for the CKD register if the result is Stage 3, 4 or 5.
   
   Or

   b) Click the Exceptions button (▼) if the result is Stage 1, 2, or if you want to exception code this patient for any other reason.

2. Click OK.

**Framingham CHD / CVD Risk Calculator**

The CHD / CVD Risk Calculator can be used from the QOF tools.

It is based on the Framingham index and uses existing data such as Age/Sex, Blood Pressure, Cholesterol, Smoking Status, Diabetes, and ECG readings to calculate a predicted risk.

The Framingham CHD / CVD Risk Calculator screen will appear, as shown below.
The upper section of the screen is used to display the data that has already been collected by the calculator from the patients clinical notes. There are also some options that you can use to modify the calculation.

The lower part of the screen can be used to view historical information, or can be used to input the relevant data. Use the drop down button (⬇) to see historical data, or use the More button (…) to enter a Read code.

1. In the Blood pressure box, choose either the **Systolic** or **Diastolic** option to base the calculation on that value.

2. In the Period box, choose either the **10 years** or **5 years** option to base the calculation on that time period.

3. Select the Read code to be entered into the patients record from the Read code drop down menu (The calculated risk is added onto the Read code selected).

4. If you want to backdate the reading, change the **Applied Date**.

5. If you want to add a priority, select it from the **Priority** Drop Down Box.

6. **Click OK.**

---

*It may not be possible to select either Systolic or Diastolic from the Blood pressure box, or 10 years or 5 years from the Period box. This occurs when some of the compulsory information is not present. The compulsory information is Age/Sex, Blood Pressure, Cholesterol, Smoking Status, Diabetes, and ECG readings. Should any of these items not be recorded then both the Blood pressure box and Period box will be greyed out.*
**JBS 2 CVD Risk Calculator**

The JBS 2 CVD Risk Calculator can be used from the QOF tools.

It is based on the Joint British Societies guidelines for the prevention of CVD. It uses existing data such as Age/Sex, Blood Pressure, Cholesterol and Smoking Status to calculate a predicted risk.

The JBS 2 CVD Risk Calculator screen will appear, as shown below.
To use the JBS 2 CVD Risk Calculator, do the following:

The lower part of the screen displays historical information, or can be used to capture relevant data. Any data that has already been collected by the calculator will be automatically filled in automatically. If there is any data missing then it will be displayed in Green and 'No Data Recorded' will be in the history column.

1. Use the drop down button (▼) to see historical data. Use the 'Contract' button (▶) to enter a Read code, or the 'BP' button (血压) in the case of blood pressure.

2. The information that is relevant is shown in the Patient Values area of the screen. This can be altered to give a 'What If' scenario. Please note that any change to these values is NOT recorded within the patient record.

3. The CVD Risk prediction is then plotted on the graph and using the legend you can see the CVD Risk over the next ten years.

4. In the Read code box, select the Read code to be added from the drop down list (▼).

5. Change the Applied Date, if required.

6. Click OK.
Peak Expiratory Flow Rate (PEFR)

The PEFR Calculator can be used from the QOF tools. The PEFR calculates the patients Peak Expiratory Flow Rate as a percentage of the target flow rate based on standard data for that age and height.

The PEFR screen will appear, as shown below.

![PEFR Screen](image)

To use the PEFR Calculator, do the following:-

1. Enter the patients PEFR by typing it into the box or using the up and down arrows.

2. The **Height** and **Age** should be displayed but can be altered/added as necessary (please note that this change is NOT recorded within the patient record).

3. The **Percentage predicted** is then displayed.

4. Read codes can be selected from the drop down boxes and the **Applied Date** can be altered if necessary by clicking on the down arrow and selecting a date on the calendar, or by typing the date directly into the box.

5. Click on **OK** to save the Read codes.
Spirometry

The Spirometry Calculator is used to record actual spirometry values and calculate what would be expected for the patient, based on their Sex, Age, Race and Height. The FEV1/FVC ratio is also calculated. The Spirometry screen will appear, as shown below.

To use the Spirometry screen, do the following:-

1. Choose a suitable reference Source from the drop down box. The three choices are E.R.S. 1993, Hankinson 1999 and Knudson 1976. The reference source selected affects which Read codes are used.
2. Choose the Test Type from the five different options. The Test Type is essentially which stage the test was performed at.
3. The patients Sex, Race, Age and Height are automatically extracted from the patients notes. The Age and Height can be altered on the screen (doing so does NOT alter them in the patients record).
4. Enter the FEV1 and FVC values into the relevant boxes. The expected values can be seen alongside, along with the expected percentage values, and the FEV1/FVC ratio.

All the relevant Read codes that will be added are displayed, and the data is plotted on the graph.

5. Select a Read code from the drop down list.
6. Change the Applied date and Priority if necessary.
7. Click OK to save.
**Add to Register**

BlueBayCT has the ability to place patients onto QOF registers in a very simple and straightforward manner. Only certain Diagnostic Read codes are applicable to the QOF, but a large amount exist in the Read code database. BlueBayCT makes it easy to add a patient onto a register by producing a list of Read codes which are applicable only to the QOF.

To add a patient onto a register make sure BlueBayCT is in **Patient Mode** and click **Add To Register** from the main BlueBayCT menu. The relevant QOF category can then be selected.

The **Read code Data Entry Screen** is presented which allows the Diagnostic Read code to be added.
Some QOF Categories require a drug to be present in addition to the Diagnostic Read codes in order for the patient to appear on the register. The drugs that are applicable are shown below the Read codes where appropriate. This list of drugs is for information purposes only and no drugs can be inputted from this area.

**Extra Indicators**

BlueBayCT provides Extra Indicators which are used by the practices for recall purposes. Extra Indicators help the practice monitor the QOF disease category recalls. These Extra Indicators allow call/recall for the purposes of monitoring, assessments, annual reviews etc. If the category already has a review as part of the QOF then that one should be used. As with other templates, **Popup Alert Indicators** are available, and patients can be sent letters from the [Practice Reports screen](#).

In addition the template can be accessed just like any other QOF template. This is done from the [QOF Templates](#) list on the main BlueBayCT menu, and then data can be input through the [Read code Data Entry Screen](#).

To view Popup Alert Indicators for the Extra Indicators, the **Extra Indicators** setting must be enabled in the [Settings screen](#).

**Prevalence Searches**

BlueBayCT provides a number of data tidy up searches which allow the practice to maintain accurate disease registers. Prevalence Searches looks for patients who have been potentially overlooked and perhaps should be on a QOF disease register. Various methods are used to locate these patients, and Prevalence Searches draws the clinicians attention to the patients for further investigation. If the patient should be on a QOF disease register then the clinician can add the relevant Read code by clicking on the **Contract button** ([ ]) in the usual way from [Read code Data Entry Screen](#). If the patient should not be on the QOF disease register then they remain on the Prevalence Searches list. It is good clinical practice for a clinician at the practice to run the **Prevalence Searches** Patient list from the [Practice Reports screen](#) a few times each year. All the usual functionality associated with Patient Lists are available. As with all other templates, the **Popup Alert Indicator** will appear advising the clinician of the Prevalence Search.
An example of a Prevalence Search is patients with Asthma related Read codes who do not have an Asthma diagnosis. It may be that the patient has a History of Asthma Read code but no Diagnosis Read code, and they may need one adding on to their record. This can then easily be done through BlueBayCT.

To view Popup Alert Indicators for the Prevalence Searches, the Prevalence Searches setting must be enabled in the Settings screen.

**Register Checks**

Another data tidy up search that BlueBayCT provides is Register Checks. Register Checks display a list of patients who may have fallen off a Register due to some reason.

An example of a Register Check is a patient who has an Epilepsy diagnosis Read code but has not been prescribed Epilepsy drugs in the last year. For a patient to be on the Epilepsy disease register they are required to have an Epilepsy diagnosis Read code and to have been prescribed Epilepsy drugs within the previous year. The patient therefore may have been overlooked, or may not have been taking their Epilepsy drug.

As with other templates, Popup Alert Indicators are available, and patients can be sent letters from the Practice Reports screen.
**Contract Templates**

To achieve maximum scores for the GMS Contract, it is imperative that all members of the practice staff are contributing to the collection of clinical and organisational data.

Practice Nurses, Healthcare Specialists and Administrative staff will find the Contract Templates an essential tool in recording GMS Contract information for any patient. Because the templates are designed to collect information in a 'step-by-step' protocol-based format, you can guarantee that by using the templates you will not forget to record or update patient data and miss out on valuable points for your audit scores. Using the templates will, of course, also help to provide better levels of patient care.

Why stop at the GMS Contract for using the templates? The software also includes a comprehensive set of customisation tools to help you 'design' the templates you want to use to help you run your clinics or collect data in your own way (See [Creating and Modifying Contract Templates](#)).

![Diabetes mellitus for HARDMAN, MARY [25/07/1944]](image)

<table>
<thead>
<tr>
<th>History</th>
<th>Diabetes mellitus</th>
</tr>
</thead>
<tbody>
<tr>
<td>DM32: Diabetes mellitus</td>
<td>30/07/2012: Insulin treated Type 2 diabetes mellitus</td>
</tr>
<tr>
<td>DM2: Body mass index not measured</td>
<td>21/08/2001: Body Mass Index 28.8</td>
</tr>
<tr>
<td>DM28: HbA1c is not 56 or less</td>
<td>No Data Recorded</td>
</tr>
<tr>
<td>DM29: HbA1c is not 64 or less</td>
<td>No Data Recorded</td>
</tr>
<tr>
<td>DM27: HbA1c is not 75 or less</td>
<td>No Data Recorded</td>
</tr>
<tr>
<td>DM21: Retinal screening not recorded</td>
<td>04/04/2011: Diabetic retinopathy screening refused</td>
</tr>
<tr>
<td>DM23: Foot examination and risk classification</td>
<td>No Data Recorded</td>
</tr>
<tr>
<td>DM12: Neuropathy testing not recorded</td>
<td>No Data Recorded</td>
</tr>
<tr>
<td>DM30: Blood pressure is 150/90 or less</td>
<td>30/07/2012: 140/80</td>
</tr>
<tr>
<td>DM31: Blood pressure is 140/90 or less</td>
<td>30/07/2012: 140/80</td>
</tr>
<tr>
<td>DM11: Microalbuminuria tested</td>
<td>30/07/2012: Urine protein/creatinine ratio 90</td>
</tr>
<tr>
<td>DM22: eGFR or serum creatinine not recorded</td>
<td>No Data Recorded</td>
</tr>
<tr>
<td>DM15: Treated with an ACE inhibitor or alpha</td>
<td>07/07/2003: Enalapril tablets 10mg</td>
</tr>
<tr>
<td>DM17: Total cholesterol is not 5 mmol/l or less</td>
<td>No Data Recorded</td>
</tr>
<tr>
<td>DM18: Influenza vaccination given</td>
<td>No Data Recorded</td>
</tr>
</tbody>
</table>
Opening a Contract Template from the Floating Toolbar

The easiest way of accessing a Contract Template is by clicking on BlueBayCT icon on the floating toolbar as below:

A drop down menu will then appear, from which you can select either the QOF or Clinical Template group.

When either of these groups is selected, another menu appears displaying the available templates.

Opening a Contract Template from the Notification area on the Taskbar

Another way of accessing a Contract Template is via the Light Bulb icon in the Notification area of your Windows Taskbar when in Patient Mode.

To open a contract template, use the following method:

1. Right-click the Light Bulb icon (💡) in the Notification area of your Windows Taskbar when in Patient Mode.

2. From the pop-up menu, select the relevant template as described above.

3. On the expanded menu, click the appropriate template for the clinical or organisational category that you want to work with.
Alternative methods of Opening a Contract Template

You can also open up a Contract Template screen from the Contract Indicators screen or Patient List screen.

Click the Show Template button ( ) on either the toolbar, or within a pop-up menu to open the appropriate template. The Contract Templates are 'context-sensitive', so it will know the correct template to open based on which clinical or organisational category is selected.

Using Contract Templates

The Contract Templates do not work in the same way that the Contract Indicators do. Even though the templates still show 'live data', you have to open the appropriate Contract Template yourself.

Unlike the Contract Indicators, Contract Templates are designed to show you what you have already recorded in addition to what you need to record. You can choose to view the template for a specific clinical or administrative category, or for all categories using the All Templates option.

The toolbar towards the top of the template window provides quick access to common functions and screens for each indicator in the template. Alternatively, you may prefer to right-click with the mouse on each indicator and choose the same function from a pop-up menu.

Default Date

The Default Date can be altered by either typing the date into the box or selecting a date from the drop down calendar ( ). Any Read codes entered will then assume the default date. This is very useful when backdating Read codes. Any Read codes added before changing the default date will be unaffected. The Default Date is set to the current date by default.

History

The History button ( ) is located next to the History column and is used to display the relevant history for that particular row.

The History button is coloured depending on how many relevant Read codes are in the row. Only the most recent Read code is displayed in the History column. If the row contains none or one relevant Read code the drop down arrow is coloured Blue ( ). When the row contains more than one relevant Read code, a drop down arrow appears in red ( ) to alert the user that more Read codes are available than the one currently being displayed.
Once viewed you can close the History window by clicking the close button (x). The window can also be resized by clicking and holding, to "drag", the resize area of the window to the required size (...:...).

Some indicators will also display a handy chart for you to see values and measurements in graphical format.

If the data being viewed is Blood Pressure History then the graph represents whichever row is highlighted. To view the graph of Systolic values highlight a Systolic row, and to view the graph of Diastolic values highlight a Diastolic row.

To the left of the History button is the History column which shows the most recently dated relevant Read code. When the cursor rests over the History column a popup window displays the entire history line, which is useful if it exceeds the width of the History column.

To the left of the History column is the Indicator Name Column which simply shows the names of the indicators. The colour coding of the indicators keeps you informed of specific time constraints. For more information on colour coding please refer to Colour Coding of Contract Indicators.
**Status Bar**
The Status Bar located at the bottom of the screen displays the history of the currently highlighted line along with the date and any relevant values.

**Toolbar**
The Toolbar is used to access the various functions e.g. contract codes, depression questionnaire, BP measurements, etc. By clicking on and highlighting lines the relevant buttons on the toolbar become enabled or disabled depending on whether they are available for use. Most of the buttons appearing on the toolbar are duplicates of those that appear alongside each category. This means that you can also access them by clicking on the buttons alongside the relevant line. A button that appears only on the toolbar and not alongside each category is the Indicator Logic Button used to view the logic used behind the category.

**Contract button**
The Contract button ( ) takes you to the Read code Data Entry Screen where Read codes can be chosen from a predefined list of relevant contract Read codes.

**Undo Last Entry**
The Undo Last Entry button ( ) deletes the Read code previously entered on that line during the current session. If multiple Read codes are added then the most recently added one is deleted first. If the Undo Last Entry button is used again it proceeds to remove the Read codes in the reverse order to which they were added. If no Read codes are available to be deleted then the button will be grey out ( ).

**Tabs**
Tabs are used to break down templates into smaller and easily manageable portions (If necessary). Select the Tab you wish to view by clicking on it, or alternatively use the previous and next buttons to move systematically through them. The History Tab is always present and is used to quickly view the history of all GMS Contract relevant data present in the patient’s notes.

**Next Tab and Previous Tab Buttons**

The Next Tab button moves forward to the next tab in the series.

The Previous Tab button moves back to the previous tab in the series.

**Next and Previous Buttons**

The Next button moves forward to the next linked Template in the series.

The Previous button moves back to the previous linked Template in the series.
Viewing Details of Contract Information
At times, you may find it useful to be able to see what information is being picked up from the Clinical System. From the Contract Templates, you can click the History tab along the top and see a categorised view of different types of information. Displayed within the History Tab are Read codes, Active Repeats, Acutes, Inactive Acute/Repeats, and Additional Information.
For example, if you are unsure of where the blood pressure readings have been recorded for the patient, you can use the **Expand (▶)** and **Collapse (▼)** buttons to look for it. You can also quickly see from this screen, which staff member has recorded this information.
Practice Reports

An essential element of the GMS Contract lies within the management of patient recalls, monitoring of point targets, and the ability to produce statistical, up-to-date reports.

Contract Administration tools have been designed to help facilitate the management aspect of the GMS Contract and assist practices with achieving the required targets. Our philosophy on working with 'live' data extends to the administration tools, so you can be sure that the information you see in target lists, recall management, point totals, and payment details is a true reflection of the status of the practice.

Accessing the Practice Reports Tools

You can only access the Practice Reports tools when you are in Practice Mode. Practice Mode is when you are logged into your clinical system and you DO NOT have any patients clinical records open on your screen. The practice mode is essentially the best practice for helping the user produce fully linear reports for

To access the Practice Report tools, use the following steps:-

1. Right-click the Light Bulb program icon ( ) in the Notification area of your Windows Taskbar.

2. On the popup menu, click Practice Reports.

The Figure below shows the different elements on the Practice Reports tools.
Within the Practice Reports screen the initial tab to appear is the Home tab. The Appearance Tab is available to change the appearance of BlueBayCT (See Changing the appearance of BlueBayCT). When a patient list is run it appears on a new tab, enabling the user to select the Home tab to run a new patient list or design Patient Recall Letter Templates. When a new patient list is run it replaces any previously run ones.

**Patient Target Lists**

The different elements of the Patient Target Lists screen for the Cervical Screening category are shown in the Figure below.

**Using Patient Target Lists**

One of the most useful features of the Practice Reports tool is the Patient Target Lists. Based on your 'live' data, these lists can readily provide you with your clinical registers, 'tidy-up' lists and targets for patients with missing indicators, and can be run off whenever you need them.
You can use them to update patient information, see which patients have more value than others, create and manage recall letters, view point totals for the category, and see which staff members are contributing towards the points.

To view the Patient Target Lists click a Category option for the list that you want to work with.

How Patient List Information is calculated
For Patient Lists that are run from Practice Reports, information is calculated using the current date as a reference and should reflect what is shown within the popup alerts screens (which is different to the default Patient Lists available from within Contract Manager). The same colour-coding is applied to patients within the list.

If you access the Patient List from within Contract Manager, information is calculated using 31 March 2013 as the reference date with any exceptions taken into account. You also have the advantage of being able to see both positive lists (completed indicators), as well as negative lists (missing indicators).

Working with Data within the Patient Target Lists
Recording Information Using Patient Lists
Just like the Contract Indicators and Templates, the Patient Lists also allow you to quickly record information using the data entry tools.

You can use the toolbar buttons at the top of the screen to add Contract codes, Exception codes, additional information and the relevant Template. And because of the 'real-time' aspect of the software, any information you record will update the patient's medical record straight away and disappear from your list.

Printing a List of Patients on a Patient List
You can print the list of patients who appear on a Patient List to obtain a hard copy. This can be useful for handouts or allocating tasks to other members of staff.

A copy of the current screen view can be printed by clicking on the Print button on the Toolbar, or to view it first click on Print Preview on the Toolbar ( ). It is necessary to expand ( ) or collapse ( ) the
Category headings and descriptions before printing as the printed copy is an exact view of how it appears on the screen.

**Looking at Other Indicators for Patients in the Patient Lists**

For any of the patients who appear within the GMS Contract Patient Lists screen, you can quickly see any other indicators that need to be completed. Simply right-click on any patient name and from the popup menu and choose **Show Indicators**. See [Contract Indicators](#) for more information on using contract indicators.

You can also see the appropriate contract template for patients by choosing Templates from the popup menu. For more information on using Contract Templates, see [Contract Templates](#).

**Opening a Patient's notes from the Patient List**

A useful integration feature allows a patient's notes to be opened directly from the Patient List. This is done by selecting the patient with a click and selecting **Open Patient** from the toolbar.

**Producing Recall Letters Using Mail Merge Tools**

Being able to recall those patients who need review is an essential feature of any clinical software application, and BlueBayCT has these tools and utilities in abundance. From letter template tools to automatic letter status recording, you'll find that this software is the one piece of software that will cater for all your call and recall requirements.

**Designing Patient Recall Letter Templates**

Letter template tools are based on Microsoft Word mail merge functions. From within Practice Reports, you can create new templates using Word, or modify and delete any that you no longer need.

To start working with recall letter templates do one of the following:

- On the Toolbar of the **Home** tab within the Practice Reports screen, click **Letter Templates** button.

  **OR**

- From the Merge Indicator screen, click the **Letter Templates** button.

The Letter Templates screen, shown below, allows you to manage the list of letter templates you have created.
The templates created on your system are shown in the main list. You can manage the templates using the toolbar buttons.

**Create a New Recall Letter Template**

To create a new recall letter template, use the following steps:

1. On the toolbar, click the **New** button ( ).

   ![New Letter Template](image)
2. Type a descriptive Name for the new template.

3. Select the checkbox of each item of information from the patients records that you would like to merge into the letter, or clear the checkbox for any items you don't require.

4. If applicable select the a Data Extract to be included in the mail merge.
   (When a Data Extract is selected, the merge fields available in the extract are made available to Word. This is an extremely useful way of getting patient data into letter form.)

5. Click OK and Microsoft Word will open up in a new window with a basic template layout displayed.

6. Use Microsoft Word to make any changes to the template layout that you require.

   You can use all of the familiar word processing features in Microsoft Word to make the layout of the letter more attractive. Any mail merge fields will appear with a {{ }} around them but you can move them around or copy them to other areas of the document if you like. They can also be formatted and justified in the usual way. Some practices will want to use pre-printed practice letterheads for their letters, so remember to allow an appropriate space at the top of the letter.

6. In Microsoft Word, click the Save button (\-).

7. Close Microsoft Word.

   You should now see the new Letter Template appear in the list on the Letter Templates screen.

**Edit or Delete Letter Templates**

To edit the content or format an existing template, or delete a template that you no longer require, use the following steps:-

1. On the Letter Templates screen, click to highlight from the list the template you want to delete or change.
2. Do one of the following:

- To edit the selected template, click the **Edit** button (️).
- To delete the selected template, click the **Delete** button (️).

**Important Information about Letter Templates**

Within the software there are some Additional Indicators to help with annual reviews. These indicators are only visible within the Contract Indicators box if you switch on the Extra Indicators parameter in the Settings screen. For more information on the Settings screen, see **Configuration & Settings Screen**.

**Running a Mail Merge from Patient Target Lists**

After creating the appropriate letter templates, you can begin producing your recall letters using the mail merge tools. You can use the Merge screen to run off your mail merge letters.

To open the Merge screen, do the following:

1. Right-click the Category, or an Indicator on the GMS Contract Patient List screen.
2. From the popup menu, choose **Merge Category** or **Merge Indicator**.
The Merge screen shows the same list of patients that appears on the Patient List screen, but allows you to perform additional tasks on the data. You can 'drag' each column to a different position to help you view the data.

The data can be sorted into a different order by clicking on the column headers, or you can use the filter buttons (_invite) to show specific patients, such as those at a branch surgery. Once a filter has been applied to the data the filter criteria is displayed at the bottom of the screen.

![Filter Criteria](image)

The filter can then be removed by clicking on the cross (_invite) alongside the relevant filter. The number of patients displayed in the list is displayed in the bottom left hand corner of the box.

3. Select the Mail checkbox for each patient that you want to recall.

If you want to select or clear all the checkboxes, click Select All or De-Select All from the Toolbar. This is useful for managing larger lists.

4. From the Letter Template list on the toolbar, choose the required template.

5. Click the Mail button on the Toolbar.

The recall letters will open in a single Microsoft Word document, ready to be printed. BlueBayCT will also add an appropriate Read code into the patient's medical record to help manage the recall status. For more information on the recall status, refer to the section below.

6. Print the recall letters and close Microsoft Word.

**Multi-Disease Registers**

When running the 'All' patient list, rather than the individual categories, you have several other options available to you for managing patient recalls. For example, you may want to perform your recalls on information such as missing blood pressures, across all of your clinical domains. You may even want to bulk recall people who are on for example either the CHD or CVD registers. You can do this by right-clicking on the patient list, and choosing the Merge Patients option on the menu. There are then a list of options to select from the list. Options selected, with the exception of All, produce a list of patients across all registers with the chosen option outstanding. When All is selected it provides a list of people who have a
contract area outstanding. The filter along the bottom of the screen allows the list to be broken down further to just that Category which is selected. Where multiple categories are selected an OR scenario exists.

E.g. Selecting both the Diabetes mellitus and Coronary Heart Disease check boxes will result in the list containing patients with Diabetes OR Coronary Heart Disease OR in fact both. This functionality is useful for sending letters to patients calling them in for a review, where the patient is on more than one disease register. In this way only one letter needs to be posted, but Read codes are posted into the patients notes for each of the disease registers that are relevant. This means when the individual disease Patient Lists are run, the invite status is correct for each.

The Merge screen is displayed, as shown below.

This screen works in much the same way as for a single QOF list, but you are able to apply a filter based on the category by selecting the appropriate checkbox at the bottom of the screen. As well as applying a filter to the list, BlueBayCT will also then add the appropriate Read code into the patient clinical record when you perform the mail merge.

**Managing the Recall Status using Letter Levels**

The Letter Level column on the Merge screen plays an important part in managing your recall letters as it gives a clear indication of which letter should be sent to each patient.

Initially, the Invite Status column will show a 1st Invite Required status, indicating that this patient should be invited to attend for review. After the initial invitation letter is sent to the patient, the status will change
to 1st Invite Performed. After the mandatory 28 day interval has elapsed, the status will change to 2nd Invite Required indicating that you need to send the second invitation letter. After the second invitation letter is generated, the status will further change to 2nd Invite Performed, and so on to the 3rd Invite Required and 3rd Invite Performed status. If the patient still did not attend after the final 28 day interval has passed, the status will change to Did Not Attend. If any patients appear with a status of ..., then they have been in for their review but did not have the indicator completed (see Entering Additional Codes).

At this point, you might want to consider exception coding these patients, which you can do from the Merge screen and is further explained in Adding Codes to Multiple Patient Records. These exception codes are typically expiring ones and only apply for 15 months contract year. On April 1st each year the invite status reverts back to 1st Invite Required regardless of any letter sent previously.

The Figure below, illustrates the recommended process for managing recall letters for the GMS contract.

Each time you produce recall letters or record a phone call using the Merge screen, the letter status will automatically increment to the next level and an appropriate Read code added to the patient clinical record. However, if you want to advance the status manually, you can do so by selecting the patient and choosing Update Invite Status from the Action menu. You will need to specify the Date that the letter was created or sent.

**Targeting High-Value Patients for Recall**

If you want to be selective about the patients that you recall for review, the software helps by showing a Value for each patient on the Merge screen, which is displayed in the Value column.

These values are calculated using a complex formula based on the projected point totals that can be achieved. Because these values are very small, they are shown to the nearest 1000th of a point, i.e. a value
of 2250 represents a potential of 2.25 points. The column is only visible when you use the mail merge from within Contract Manager.

**Recalling Patients by Phone**
You may prefer to invite the patient to attend for an appointment by speaking with the patient directly on the telephone. Patient phone numbers are displayed in the Telephone No column on the Merge Screen. An appropriate Read code to indicate that you have telephoned the patient can be inserted into the patients record, by clicking on the Phoned button. This will also result in the Invite Status being updated.

**Adding Codes to Multiple Patient Records**
The Merge screen is also useful for adding contract, or exception codes, to several patient records at once. This feature is particularly useful when used as part of your recall procedures. After you have invited your patients for review for the 3rd time, you will more than likely be left with several patients who will not attend. You can add the appropriate exception code to all of these patient records with a few simple clicks using the Merge screen.

To add contract or exception codes to multiple patient records, use the following method:-

1. Right-click an indicator on the GMS Contract Patient List screen.
2. On the popup menu, click **Merge Indicator**.
3. On the Merge screen, select a checkbox for each patient that you want to add the code to.
4. Do one of the following:-
   - Click the Contract button ( ) to add contract codes
     (See **Read code Data Entry Screen**).
   - Click the Exceptions button ( ) to add exception codes.
     (See **Exception Read codes**).
   - Click the Read codes button ( ) to add non-contract codes.
     (See **Read code Data Entry Screen for non-contract codes**, below).
5. Click **OK**.
   The Read codes will then be added to the patients records. This may take a short while depending on how many patients are selected. A blue progress bar appears along the bottom of the screen.
Read code Data Entry Screen for Non-Contract codes

You can specify multiple Read codes to be added to the patients notes that do not have to be contract codes. They can be essentially any Read codes in the Read code database.

To add Read codes, use the following steps:

1. Click on the Codeset button ( ula ) to assign your Read codes.

The Read code search screen will appear allowing you to search for Read codes, either by keyword or by the actual Read code.

4. Type in a keyword description, or the specific Read code that you want to search for and click Search.
A list of matching Read codes will be displayed in the left-hand column. If the Read code you want is not displayed in the search list, simply type another keyword or Read code and click **Search** again.

5. In the left-hand column, click to highlight the Read code you want to use for the data entry field.

6. Click the Arrow right button ( ▶ ).

The Read code that you select will be added to the column on the right-hand side of the window. You can repeat this process and continue adding as many Read codes as you like to the right-hand column. If you make a mistake and want to remove a Read code, click to highlight the Read code in the selected list and click the Arrow left button ( ◄ ).

7. When you are happy with the Read code(s) that you have chosen, click **OK**.

The Read code Data Entry screen appears containing the selected Read codes. The Apply box is ticked by default for all of them (see **Read code Data Entry Screen**).

8. Click **OK** to add the Read codes.
**Server Login Details button**
The Server Login Details button on the Toolbar is used to enter and store the login details that enable BlueBayCT server application to connect to the Clinical System database. This button will only be available for users of some Clinical Systems. It may be necessary to use this button to alter the login details if the server passwords are changed. It should only be used by advanced users, and only when asked to do so by the BlueBay Support team.

*Warning*
Improper use of the Server Login Details button will lose connection with the Clinical system, and should only be used by advanced users when asked to do so by the BlueBay Support team.

**Synchronise button**
The Synchronise button on the Toolbar allows an immediate adhoc synchronisation of BlueBayCT from all the patients clinical records. This ensures the reports that are generated are completely up to date as of when the synchronisation is performed. Details of the last time a synchronisation was performed is displayed in the bottom left hand corner of the Practice Reports screen. Once started a synchronisation cannot be stopped and must be allowed to run through in its entirety. Depending on the patient list size this may take a few minutes.

Synchronisation is programmed to run automatically in the early hours of the morning and it is not usually necessary to perform an adhoc synchronisation under normal circumstances.

**Last Run button**
The Last Run button on the Toolbar enables the user to quickly view the last Patient List that was run, displaying the data exactly as is was displayed at the time it was originally run. Last Run is therefore not a live list. However, it is very useful as under normal circumstances a Patient List that was run just a few hours before will not normally change dramatically over a few hours.

*Tip*
Some practices choose to run the ALL Patient List first thing when they arrive at surgery. This enables the Last Run button to be used throughout the day rather than running the patient list again and again.

**High Value Patients**
High Value Patients are a list of the top 25 patients with outstanding indicators that have a corresponding high points/financial value. These are essentially the patients who, if the surgery calls in and completes the outstanding indicators, are worth more than the average patient. This can be due to the fact that they appear on multiple registers or indeed are one of a few patients on a small register, which needs only one
more patients to meet the threshold to achieve full points for that indicator. The High Value Patients list is most useful towards the end of the QOF period having the most impact in the last few weeks.

To open High Value Patients, do the following:-

1. Open the Practice Reports screen (See Accessing the Practice Reports Tools).
2. Click High Value Patients from the QOF area of the screen.

The High Value Patients screen will appear, as shown below.

A list of patients is displayed. When expanded, the list shows exactly which indicators provide what points. This list can be printed or the usual data entry tools are available by right-clicking on the indicators.

The numerical Value represents one thousandth of a practice point. It is the potential points the practice will earn for completing the displayed indicators for the given patient. E.g. If a patient has a Value of 2043, then the points earned if all the indicators are satisfied is 2.043 (All the other factors remaining the same).
**Contract Manager**

Contract Manager is an essential tool for monitoring your practice performance over the year. Presenting an overall view of your point totals for the practice, Contract Manager can be used to track aspirations, help plan monthly workloads, compare year-on-year performance, show your practice prevalence and provide you with financial information. All information displayed by default uses the end of the QOF year (i.e. 31 March) as the reference date so point totals are cumulative as you work through the year. Changing the Forward Date settings will not affect Contract Manager.

To open Contract Manager, do the following:-

1. Open the **Practice Reports** screen (See Accessing the Practice Reports Tools).
2. Click **Contract Manager** from the QOF area of the screen.

**The Contract Manager Screen**

The Contract Manager screen is divided into different sections. The title bar displays the date that the Contract Manager was last updated and you can access the different commands and functions using the toolbar.

![Contract Manager Screen](image)
The navigation area on the left hand side of the screen allows you to view information in the right-hand side pane. As you click on the different domains and categories, you'll see the information on the right-hand side of the screen change accordingly.

The upper right-hand side of the screen displays a grid showing detailed information about the indicator, current point totals, maximum possible points, your aspiration target if set, and the expected payment (which can be adjusted using the Payment and Prevalence Information screen). You can adjust your aspiration target by clicking into the Aspiration or Asp % cells and using the buttons to adjust the value.

As you click on the different indicators within the grid, the charts within the lower right section of the screen changes to a graph to enable comparison of the actual points the practice has obtained to that which it aspires to. You will also be able to use the chart to see the historical trends for the points for the particular indicator that you have clicked on in the grid. These are typically shown on a month-by-month basis for the current QOF year.

The status bar at the bottom of the screen is a very useful tool and shows some important information relating to point thresholds. You can see from the sample screenshot above, the current Percentage, the number of patients With indicator, the number of patients Without indicator, the upper and lower Thresholds for the indicator (%) and the Number needed to reach the target. Towards the end of the contract period the Number needed to reach the target can play a vital role when allocating resources in order for the practice to attain the maximum points possible for each category.

**Updating Contract Manager**

Before you can use Contract Manager, you'll need to update it with information from your clinical database. To update Contract Manager, click Current Results on the Toolbar and select Update. The data displayed is the current points achieved using the end of the current QOF year as the reference date. Depending on the size of your practice, it might take a while to update Contract Manager’s statistics. You can cancel the update at any time by clicking the Abort button (عكس). The time that has elapsed since the start of the update and the number of patients processed is shown along side the Abort button.

once updated there is no need to exit contract manager to run a patient list. the patient list has already been updated and is available from within contract manager. to access it within contract manger, click current results on toolbar and select patient list. if contract manager has not been updated then the patient list option will not be available.

**Navigating Through the Different Contract Domains**

By default, the Contract Manager screen displays the totals for each domain under the Domains section on the toolbar. You can break down and view each domain by clicking on the domain in the toolbar. When in a Domain, click on the area of interest to view it in the right-hand pane.

62
Working with Data on the Contract Manager Screen

**Viewing Contract Point Statistics**
You can obtain instant point calculations for any of the clinical categories, compare your actual point totals with your aspirations, and you can even filter the statistics down to individual staff members and find out who is contributing the most to your totals!

To view Contract Point Statistics on the GMS Points screen, use the following method:

1. Firstly select **Current Results** and then select **Update** from the toolbar within the Contract Manager screen. This makes sure the information is up-to-date.
2. Click on an Indicator Description in the right-hand pane to highlight it.
3. From the toolbar, select **Indicator Points**.

The GMS Points screen will appear, as shown below.
**Using the Points Screen**

Use the GMS Points screen to view your point totals. You can filter down to individual indicator points by selecting the required item in the Indicator list. A breakdown of the statistics is displayed in the summary box on the right-hand side of the screen. A useful chart is also provided to show your point totals in graphical form.

To enter your practice aspirations for comparison with your actual totals, you will need to filter down to individual indicators first. Then use the Aspiration box to enter the value for that indicator. When you look at the category total, it will calculate your overall aspiration based upon the values entered for individual indicators.

The screen also provides a method of seeing point contributions from different staff members at the practice. Use the Staff list to select the user name of the staff member you want to view. The chart and the breakdown summary will change accordingly.

![When filtering point totals by staff member, be aware that the information is based on the individual who is actually recording the encounter. This may not always be the staff member recorded within the encounter information.]

**Entering Manual Point Information**

Although the majority of information on the Contract Manager screen is automatically calculated from your clinical database, there are a number of items which will require manual entry of point information.

For example, much of the information in the Organisational domain deals with practice procedures and there would be no possible way of gathering this information as it is not stored in the clinical database. Therefore, this type of item has to be entered manually. To make it easier to identify manual point information, these types of indicators are coloured Blue, as opposed to the Black ones, which BlueBayCT automatically calculates from the clinical database.

To enter manual point information, do the following:-

1. Use the Navigation Bar on the left-hand side to browse to the required domain.
2. In the grid on the right-hand side of the Contract Manager screen, click into the Points column.
3. Up and Down buttons (↑↓) appear and can be used to adjust the value.
4. Manual entries will always be 'Yes' or 'No' answers, so you can only set the value to the maximum possible which is effectively 'Yes', or zero for 'No'.
5. When complete, click the Save button (✓) on the top Toolbar to save your changes.
Adjusting Point Aspirations

A key feature of Contract Manager is the ability to be able to enter your point aspirations. If you feel that the practice will fall short of meeting the maximum points for an indicator, you can 'estimate' how many points the practice will aspire to achieving and compare this with your actual performance. Aspirations can be entered as a point value, or as a percentage of the maximum point totals.

To enter your aspirations, use the following method:

1. Use the Navigation Bar on the left-hand side to browse to the required domain.
2. Do one of the following:
   - To enter your aspirations as a point value, click into the required cell under the Aspiration column in the grid.
   - To enter your aspirations as a percentage of the maximum point total, click into the required cell under the Asp. % column.
3. Use the Up and Down buttons (▲▼) to adjust the value, or type a value directly into the cell.
4. When complete click the **Save** button (✓) on the top Toolbar to save your changes.

The graph on the screen changes to reflect the aspiration value, which is shown as a **Blue** line.

Opting out of Clinical Categories

Some practices may choose to opt out of one or more clinical categories providing the Health Board agrees, and Contract Manager can be altered to reflect this. For example, if the practice is not capable of providing an Asthma service, the Asthma register points column can be reduced to zero points. The category registers are displayed in **Blue** to indicate that the Points can be altered manually. By default the category registers are set to the maximum available points.

To opt out of a clinical category, use the following method:

1. Use the Navigation Bar on the left hand side to browse to the required category.
2. Click into the Points column on the **Blue** Category Register line.
3. Use the Up and Down buttons (▲▼) to adjust the value, or type a value directly into the cell.
4. When complete click the **Save** button (✓) on the top Toolbar to save your changes.
Specifying Payment and Prevalence Information

Payment information that you see displayed on the Contract Manager screen may not be accurate unless you make sure that your practice payment and prevalence information is correct. This is entered from the Payment Details Screen.

To enter prevalence information, do the following:

1. **Click Payment Details** on the Toolbar. The Payment Details screen will be displayed, presenting the default screen for Prevalence information.

2. Use the Up and Down buttons (↑↓) to adjust the National prevalence value.

3. When the changes have been made click **OK**.

This screen is also used to view your actual practice prevalence information, which is calculated from your live clinical data each time the results are updated. National Prevalence data can be found at [http://www.gpcontract.co.uk](http://www.gpcontract.co.uk).
To enter Payment information, do the following:

1. Click **Payment Details** on the Toolbar.
2. Click on the **Practice** Tab.
3. Use the Up and Down buttons (↑↓) to adjust the Pounds per point and the National average list size.
4. When the changes have been made click **OK**.

To enter National average % for those items that affect your payments for additional services, do the following:

1. Click **Payment Details** on the Toolbar.
2. Click on the **Additional Services** Tab.
3. Use the Up and Down buttons (↑↓) to adjust the National average % for Additional Services.
4. When the changes have been made click **OK**.

Changes made to the Payment Details screen will only be permanently saved when exiting Contract Manager. When you exit Contract manager you will be asked if you want to save the changes. Click 'Yes' to make these changes permanent or 'No' to remove any changes.

**Generating a Points Report from Contract Manager**

From within the Contract Manager screen, you can generate a simple points report which provides you with detailed information about your current points totals, aspirations and payment information for QOF.

To generate and print a Points Report, do the following:

1. From the Toolbar choose **Points Report** and then click on the relevant date.
2. You can print out the report using the Print (↑↓) or Print Preview (↑↓) buttons on the toolbar.

Alternatively the information shown in the report can be saved as an Excel spreadsheet. To do this click on the CSV File button (↑↓) on the Toolbar, then give the file a name and specify the location you want to save it.
Generating a Percentage Report from Contract Manager

From within the Contract Manager screen, you can generate a more advanced percentage report which provides you with charts and graphs about your current targets, including detailed information about each category and indicator for QOF.

To generate a Percentage Report, do the following:-

1. From the Toolbar choose **Percentage Report** and then click on the relevant date.

To view the reports, you will need to have a PDF document viewer, such as Adobe Acrobat, installed on your system. You will need to have at least version 7 of Adobe Acrobat reader installed on your client PC before this option will run.
Updating and Displaying Yearly Results
The Contract Manager screen is useful for looking at your current QOF status but by default, all of the information is calculated using cumulative totals to the reference date of the next 31st March.

You may find it more useful as you work through the year to generate 'rolling totals' and specify your own reference date, e.g. for the next 3 months. It may also be necessary to look back to the previous QOF year. You can do this by using the Yearly Results option. It is worth noting that most practices will primarily use the Current Results button to update their points, and using the Yearly Results produces non-standard results.

To update Contract Manager using the Yearly Results option:-

1. On the Toolbar, select **Yearly Results**.
2. In the date field on the menu, type a new reference date, or choose a new date from the calendar.

3. From the menu, click **Update**.

Contract Manager will then display the Yearly Results on the screen instead of the current results. If you have previously performed a Yearly Results update and want to view the results again, choose Yearly Results from the Toolbar and then Display.

**Printing Information on the Contract Manager Screen**

You can print the information that is displayed within the Contract Screen to obtain a hard copy. This can be useful for handouts during practice meetings.

To print the points grid click **Print** on the Toolbar, or to view it first click on **Print Preview** on the Toolbar ( ).

To print the points chart click **Print Chart** on the Toolbar, or to view it first click on **Print Preview Chart** on the Toolbar ( ).

**Exporting Information to a CSV File**

The information displayed within Contract Manager can be exported to an Excel spreadsheet for analysis and manipulation. This is a very useful feature as it allows the usual Excel functionality to be applied to the contract data.

To export the data that is currently being viewed, do the following:-

1. From the Toolbar menu, click **CSV File** ( ).

2. In the Save As window that follows, type a name for the CSV file and the location where you wish to save it.

3. The saved file can then be opened in Excel, by pointing Excel to the location in which the file was saved.

**Shrinking / Enlarging the graphs**

The size of the graph can be changed to allow a larger more detailed view, or by making it smaller which allows more of the table to be viewed. This can be achieved by clicking on and Dragging the Dividing Bar between the table and the graph. Double clicking on the dividing bar sizes the graph to full screen.
Data Extract

The Data Extract screen can be accessed from the Practice Reports screen, in the Other tab. It allows data to be extracted into a CSV (Comma Separated Values) file. This file can then be forwarded on if necessary to Health Boards etc, who can analyse the data. This function is aimed at templates that have been created for a specific purpose.

To run a Data Extract, do the following:-

1. On the Practice Reports screen, click on the Other tab on the toolbar, and select Data Extract.
2. From the Select Ruleset window, choose the Ruleset you wish to Extract.

3. Change the Report Date by selecting a new date from the drop down box or typing it directly into the box if you want to run the Data Extract based on a date in the past.

4. Click the **Multiple Files** option to toggle it if you wish to get a CSV file for each column that has been defined.

To save confusion the **Remove Old Files** button on the toolbar purges all previous occurrences of the extract. This was introduced to simplify the process of locating the correct extract file. Extracted files are stored in NetworkShare\PracticeCode\DataExtract. The file name is comprised of the Ruleset name, practice code and the date/time of the extract. Clicking on the Folder button on the screen that follows will open up the Data Extract location in Windows Explorer.
Configuration & Settings

There are several configuration settings that can help you to use the software in the most effective way for your practice. Changes made from within the settings screen only affect the user who is logged into the Clinical system, and the settings remain with that user. The one exception is for the cervical recall period which is global to the practice.

Using the Settings Screen

To open the settings screen, do the following:

1. Right-click the Light Bulb icon (💡) on the Notification area of the Windows Taskbar.
2. From the popup menu, click Settings.

Various Tabs are displayed on the left hand side, and can be clicked to access the array of configuration and settings.

Options Tab

The Options tab on the Settings screen contains configuration parameters that will affect how the software appears on your screen, and how it will interact with your clinical system. Please make sure that you are fully aware of what these settings are used for before you change them.
**Roles**
The Roles area on the Options screen contains configuration parameters that will affect how the software appears on your screen. By selecting GP, Nurse or Admin, the predefined recommended options for each role are selected automatically.

For example, selecting Admin, does not display the Extra Indicators. This means the administration staff will not view Influenza triggers as they are not relevant to the role of the administrator. The Nurse however will need to see the Influenza pop-ups. The four options available are listed below:

- **Extra Indicators** - Select this checkbox to view indicators (see Extra Indicators).
- **Notes Summary** - Select this checkbox to view the notes summary indicator.
- **Prevalence Searches** - Select this checkbox to view tidy-up register searches (see Prevalence Searches).
- **Exception Lists** - Select this checkbox to list all patients who are exception read coded from the various categories.

The Custom role allows users to select exactly which options they want if none of the pre-set roles be applicable.

**Indicators**
The other settings on the screen are used to switch off the indicators, or different sections of the indicators:

- **Disable Auto Popup** – Select this checkbox to stop the indicator popup from automatically appearing on screen when opening a patients notes during the consultation. When this option is checked the indicators can still be accessed from the floating toolbar.

- **Combine Triggers** - Select this checkbox to combine the QOF and all the other buttons into one. This can help reduce the on screen presence of the floating toolbar.

- **Disable User Defined Indicators** - Select this box to disable the use of user defined rules created using the Rule Designer.
**Forward Dating Tab**

The Forward Dating Tab within the Settings screen provides three different options for forward dating of indicators. These options will change the information that you see displayed in the Contract Indicators, Contract Templates and Patient Target Lists (the reference date is clearly shown on these screens).

To change the forward dating, select the following option:-

- **None** – Only those indicators requiring completion as of today's date will be shown.
- **Forward Date** – Will also show those indicators that have already been completed as of today's date, but will need to be re-recorded before a specified reference date. You can set this date using the date picker or by typing in a date.
- **Rolling Days** – Will also show those indicators that have already been completed as of today's date, but will need to be re-recorded within a specific number of days ahead. You can set the number of days using the Days field.
If you choose the Forward Date or Rolling Days option, you also are able to select the **Show Inactive Triggers** checkbox to display those items that will need recording in the future, but cannot be recorded within the specified time period. Depending on which option you have selected, the indicators will appear in different colours in the other screens. For more information on the colour-coding of indicators, see [Colour Coding for Contract Indicators](#).

**Advanced Tab**
The Advanced Tab is used to control advanced setting options. These settings will probably not be required for an average practice and should only be used by advanced users.

- **Skin** – The option allows the user to select a different ‘look’ for BlueBayCT. The default skin is set to ‘Office2010Silver’.
- **Disable QOF Triggers** - This option disables the QOF triggers from showing, either on the floating toolbar or the Contract Indicators screen.
- **Show Triggers for Yearly Exceptions** - Select this checkbox if you would like to see any previously recorded exceptions for the current QOF year. This is useful if you have previously used an exception code, but may want to record QOF data later.
• **Cervical recall period** - This button determines how often cervical smears are required. This setting is set to every 5 years by default, but a small number of health boards require this to be done every three years. Please contact your Health Board if you are unsure.

• **Categories Button** - Clicking this button provides another screen where the user can select which whole categories they want to appear in the contract indicators screen by placing a check in the corresponding boxes.

• **Indicators Button** – Clicking this button provides another screen where the user can specify which individual indicators within categories should be displayed in the contract indicators screen, in much the same way as the Categories button.

**Scheduler Tab**
The Scheduler tab can be used to schedule the running of Contract Manager, Data Extracts, or any of the Patient Lists. This is particularly useful if you want to run these tools at a more convenient time, or you are unable to run them during the day.

To schedule the running of Contract Manager, QOF Patient Lists, GSFS Reports or Data Extracts use the following method:-
1. In the Schedule option list, do one of the following:
   • Click **None** to disable the schedule.
   • Click **Contract Manager** to schedule an update of Contract Manager.
   • Click **QOF List** to schedule the Patient Target Lists for QOF.
   • Click **Data Extract** to schedule a specific data extract.

2. In the Frequency option list, choose one of the following:
   • **Daily** – Schedule the task to run every day.
   • **Weekly** - Schedule the task to run on a specific day of the week.
   • **Monthly** - Schedule the task to run on a specific day of the month.

3. In the Weekly option list, choose the required day of the week, if the Weekly option was selected in step 2.

4. In the Monthly option list, choose the required day of the month, if the Monthly option was selected in step 2.

5. In the Schedule Time box, enter the time that you want the schedule to start in 24hr format.

6. In the Data Extract drop down box, select the data that you wish to extract, if Data Extract was selected in step 1.

7. Click **OK** to set the schedule.

---

**Order Tab**

The Order tab of the Settings screen can be used to alter the order of the Contract Indicators. Normally the Contract Indicators are ordered alphabetically. By moving some or all of the Contract Indicators from the left hand column to the right-hand column you can specify the order and bring more important indicators to the top of the list. Any Contract Indicators that are remaining on the left hand side of the screen are placed at the end of the list in alphabetical order. By default all Contract Indicators appear alphabetically in the left hand list, and are also displayed in this manner.

---

After you set the scheduler to run, you will need to leave your PC running at the time you specified.
Protocols Tab

The Protocols Tab allows the user to further customise the alert indicators by selecting whether to show high, medium or low priority indicators and whether or not you want to combine them. This setting only applies to additional items that you have downloaded into your system, such as SIGN guidelines or NICE guidelines. All QOF alert indicators are excluded from this configuration.
• **Alert Priority** - Defines what indicators are shown for Enhanced Services, SIGN Guidelines, NICE Guidelines and Other protocols. A High priority will only show those indicators marked as 'High Priority'. Choosing Medium will show those indicators marked as both 'High Priority' and 'Medium Priority'. Choosing Low Priority will show all classes of indicator.

• **Combine Protocol Alerts** - Select this option to combine all downloaded Enhanced Services, SIGN guidelines, NICE guidelines and Other protocols into a single alerts list.

**Reset Position Button**

The Reset Position button on the Settings screen simply sets the Contract Indicator popup screen back to the original default position and size. The software remembers the size and position of this screen, when altered, so the Reset Position button is a means of changing it back to as it was when the software was first installed. This is especially useful if the Contract Indicator popup screen has been moved out of view of the screen and cannot be brought back.
Changing the Appearance of BlueBayCT

Changing the appearance of BlueBayCT can be done by altering what is known as a skin. A skin is basically the general colour and overall appearance of the BlueBayCT screens and can be changed from the default to suit the individual users taste. The skins are set within the Advanced tab in the Settings Screen or any of the template screens in the Appearance tab. The functionality of BlueBayCT is not altered when appearance settings are changed. Changes made are stored against a clinical system user, therefore changing the appearance for one user does not alter that for the whole practice. The default skin in for Appearance is “Office 2010 Silver”.
Creating and Modifying Contract Templates
The BlueBayCT software includes a comprehensive selection of templates to help you manage your QOF data. However, there will probably be occasions where you would want to modify the templates slightly to suit the way that you run your surgeries and clinics. Any of the standard QOF Templates included can be 'customised' with additional Read codes and screening tools.

Alternatively, you may want to create your own data entry templates for capturing and recording clinical information. For example, you may want to set up your own template for a Smoking Cessation clinic, or a Well Person Clinic. The possibilities are endless.

Templates that you modify or create are stored on your practice server, allowing you to share these with the rest of your colleagues within the practice.

Accessing the Template Designer Tools
You can access the Template Designer tools by right-clicking on the Light Bulb icon (💡) in the Notification area of your Windows Taskbar. This option is only available when you are in Practice Mode. Practice Mode is activated when you are logged into your clinical system and you DO NOT have any patient clinical records open on your screen.
You can access the different functions and tools from the Toolbar menu, on the Tabs located above the Toolbar. Available Tabs are File, Home and Layout. In addition a tab called Appearance is present (See Changing the Appearance of BlueBayCT). The main area of the screen acts as the 'canvas' for you to build up data entry rows within the template. There is no limit to the number of rows that you can add to your templates. Rows can be either Added or Inserted into the template. When a row is Added to the template it appears at the bottom of all the existing rows, which is the method described below. In addition a row can be inserted into the template, the difference being it appears just above the currently selected row (See Inserting a Row into the Template).

Three options are available to the user:-

- **Customise an existing QOF template.** Any new user defined rows appear below the selected QOF rows on the actual existing QOF templates. In this way you can customise existing QOF templates.
- **Create a new user-defined template.** This option starts with a completely blank template. Templates created in this manner, once created, are accessed from the Clinical Templates menu on the main menu.
- **Replace an existing QOF template.** This option starts with a completely blank template which appears in place of the actual existing QOF templates.

### Customise an Existing QOF Template
If you want to customise any of the existing Contract Templates by adding some additional measurements or values, you can do so using the Template Designer.

To customise an existing Contract Template, do the following:-

1. Click on the File tab to select it.
2. From the Add to QOF section click an existing Category from the list.

The selected template then opens and you can now add indicators to customise the template. However, the current QOF ones cannot be amended or deleted. For more information on adding and deleting indicators, see Adding New Codeset Rows to the Template.

### Create a New User-Defined Template
To help you run your surgeries and clinics, why not create some new templates which you can use to capture information during the consultation with the patient?
To create a new user-defined template, use the following steps:

1. Click on the **File** tab to select it.
2. From the right-hand pane click on **New Template**.
3. Type a name for the new template.
4. Click **OK**.

A blank template then opens and you can now add indicators to create a template. For more information on adding and deleting indicators, see [Adding New Codeset Rows to the Template](#).

**Replacing an Existing QOF Template**

If you want to completely replace an existing QOF template with a user-defined one, you can do so using the Template Designer. In effect it means that in the place of where the normal QOF template appears, the replacement is displayed.

To replace an existing Contract Template, do the following:

1. Click on the **File** tab to select it.
2. From the **Replace QOF** section click a Category from the list.

The selected template opens but appears blank. You can now add indicators to customise the template. If necessary the category QOF rows can be inserted by [Adding a Contract Row](#). For more information on adding and deleting indicators, see [Adding New Codeset Rows to the Template](#).

**Opening Existing User-Defined Templates**

To open an existing User-Defined template, use the following steps:

1. Click on the **File** tab to select it.
2. Click **Open** on the left-hand side.
3. Select a template to be edited from the Open dialog box that appears.

4. Click **OK**.

### Working with Indicators in the Template Designer

#### Adding a Header or Footer Image to a Template

Instead of adding an image to each page within your template, it's recommended that you use the Header and Footer functions within the Template Designer. This will automatically format the image and place it on each page. It also protects the image from being deleted or edited. Header and Footer images need to be in the format .jpeg .jpg or .Bmp.

To add a Header to your template, do the following:-

1. On the **Layout** tab, choose **Header** from the Toolbar.
2. Use the Open dialog box to browse to the location of the image file.
3. Select the file you want to use as your header image and click **Open**.

To add a Footer to your template, use following method:-
1. On the **Layout** tab, choose **Footer** from the Toolbar.
2. Use the Open dialog box to browse to the location of the image file.
3. Select the file you want to use as your footer image and click **Open**.

If you need to remove the Header or Footer from your template, you can choose **Clear Header** or **Clear Footer** from the Toolbar.

---

**Creating a Menu Image for the Template**

To make your new template 'stand out' when looking through your clinical templates, the Template Designer allows you to attach a small image which is displayed on the menu.

To attach a menu image to the Template, do the following:

1. On the **Home** tab, click the down arrow alongside **Menu Image** button (  ).
2. Select **Change Menu Image**.
3. Use the Open dialog box to browse to the location of the image file.

4. Select the file you want to use as your menu image and click **Open**.

---

**Adding Multiple Pages to Your Template**

If you have a lot of information that you need to record from your Template, it's recommended that you organise your data fields into logical groups and create separate pages for each group within your template. If you've set a header and footer image, these will automatically appear on each separate page.

To add a new page to your template, click the **Add** button ( ![Add](image) ) in the **Pages** area of the Toolbar located on the **Home** tab. You can give the page a suitable name by clicking on the Page Caption box and typing a new name.

If you want to delete a page, click the **Delete** button ( ![Delete](image) ) on the **Page** area of the Toolbar located on the **Home** tab. You can re-order your pages by clicking on the page you want to move and then using the **Left** ( ![Left](image) ) and **Right** buttons ( ![Right](image) ) accordingly.

**Changing the Appearance of Page Markers**

Page markers, also know as tabs, that are allow a template to have multiple pages can be altered in colour so they are more appealing and stand out. The tab colour and the text colour can both be changed. This is done by selecting the **Colour** and **Font Colour** from the **Pages** area of the **Home** tab. When a colour is selected it affects the tab that is currently in use only. Each tab needs to be set individually.

---

**Adding New Codeset Rows to the Template**

Codesets are one of the most useful types of data entry fields you can add to your template. Using codesets, you can specify multiple Read codes in a list, and use these to record information for the patient. These work in a very similar way to the QOF data entry fields.

To add codeset rows to the template, use the following steps:

1. On the **Home** tab, select the **Add Codeset Row** ( ![Add](image) ) from the **Controls** area of the toolbar.

2. Type a meaningful name or description for the field.
This can be up to a maximum of 50 characters long and can contain a mixture of letters, numbers or special characters.

3. Click on the Codeset button (📖) to assign your Read codes.

4. Type in a keyword description, or the specific Read code that you want to search for and click Search.

A list of matching Read codes will be displayed in the left-hand column. If the Read code you want is not displayed in the search list, simply type another keyword or Read code and click Search again.
5. In the left-hand column, click to highlight the Read code you want to use for the data entry field.

6. Click the Arrow right button ( ).

The Read code that you select will be added to the column on the right-hand side of the window. You can repeat this process and continue adding as many Read codes as you like to the right-hand column. If you make a mistake and want to remove a Read code, click to highlight the Read code in the selected list and click the Arrow left button ( ).

7. When you are happy with the Read codes that you have chosen, click OK.

Another useful feature is the ability to specify standard free text entries for the Comments field. This can be used to quickly insert common entries, or to help prevent typographical errors and spelling mistakes. To do this, click the Description button ( ) and type each of your free text entries separated by a “tilde” character (~). When you are using the template to record information, each entry will appear in the Comments drop down box for that field. E.g. “Offered at School~Offered at Youth Club~Offered at Girl Guides~Offered at Scouts”. When Comments are pre-defined as described above, they replace the standard stored Comments saved in the Comments Button.
Adding Existing QOF Indicators to the Template

You might find it more convenient to add existing QOF alert indicators to your new template. This will help to ensure that you are recording information that is consistent with QOF.

To add an existing QOF indicator, use the following procedure:

1. On the Home tab, select the Add Contract Row ( ) from the Controls area of the toolbar.

   The Select Indicator screen will appear allowing you to choose an existing indicator from another clinical or administrative category.

   2. Use the Expand or Collapse buttons ( ) to browse through the categories.

   Pre-defined free text entries are displayed in Comments drop down box.

   It is also possible to delete a row by right clicking on the row, and selecting the Delete from the menu. In the same way rows can be added and inserted by clicking on an area of the window that does not contain any rows.
3. Click the indicator that you want to use on your template.

4. Click OK.

The existing indicator is now added to your template. The row name will be automatically filled in with the standard QOF name, but can be altered as necessary.

Adding a Read code Row to the Template
The Read code Row works in a similar way to the Codeset Row, but you are only able to specify a single Read code. When the user then clicks to record information for the patient, a simple data entry box is displayed where the user can input a value or measurement e.g. Waist Circumference as below.

![Waist Circumference in CM](image)

This is most useful when used to record test results or specific screening measurements.

To add a Read code Row to the template, use the following procedure:-

1. On the Home tab, select the Add Read Code Row ( ) from the Controls area of the toolbar.

2. Type a meaningful name or description for the field.

   ![Waist Circumference in CM](image)

   This can be up to a maximum of 50 characters long and can contain a mixture of letters, numbers or special characters.

3. Click the Read code button ( ) to choose the Read code.
The Read code search screen will appear allowing you to search for Read codes, either by keyword or by the actual Read code.

4. Type in a keyword description, or the specific Read code that you want to search for and click **Search**.

A list of matching Read codes will be displayed in the left-hand column. You can use the More Detail and Less Detail buttons (<< >>) to browse through the hierarchy for the Read code. If the Read code you want is not displayed in the search list, simply type another keyword or Read code and click Search again.

5. In the left-hand column, click to highlight the Read code you want to use for the data entry field.

6. Click the Add button (▶).

The Read code that you select will be added to the column on the right-hand side of the window. You can only select a single Read code for the Read code Row. If you make a mistake and want to remove the chosen code, click to highlight the Read code in the selected list and click the Remove button (↩).

7. Click **OK** to save the Read code.

8. To add some units of measurement to the Read code, click the Add Units button (liği).

9. In the Read code Units box, type the units of measurement.
10. Click **OK** to save the units.

**Adding Blood Pressure Rows to the Template**

The Blood Pressure data entry tool allows you to record a Blood Pressure measurement for the patient and is far simpler and quicker than having to select a Read code. All you need to do to record the information is to type the systolic and diastolic values, and the Read coding is done automatically for the user.

To add Blood Pressure rows to the template, use the following steps:-

1. On the **Home** tab, select the **Add Blood Pressure Row** from the **Controls** area of the toolbar.
2. Type a meaningful name or description for the field.

   ![Blood Pressure](image)

This can be up to a maximum of 50 characters long and can contain a mixture of letters, numbers or special characters.

**Adding BMI Rows to the Template**

Recording BMI values is made much easier when you use the BMI data entry tool in BlueBayCT. The user simply has to enter the height and weight for the patient and the BMI calculation will be done automatically. The user can enter the height and weight values in either metric or imperial units of measurement. All the necessary Read coding is done automatically by the tool.

To add BMI rows to the template, use the following steps:-

1. On the **Home** tab, select the **Add BMI Row** from the **Controls** area of the toolbar.
2. Type a meaningful name or description for the field.

   ![BMI](image)

This can be up to a maximum of 50 characters long and can contain a mixture of letters, numbers or special characters.

**Adding Smoking Rows to the Template**

Recording details on the patients smoking habits can be done by adding a smoking row to the template. When clicked the user can enter Read codes on smoking status along with any cessation advice. The number of tobacco products smoked per day can also be recorded, as shown below.
To add smoking rows to the template, use the following steps:

1. On the **Home** tab, select the **Add Smoking Row** () from the **Controls** area of the toolbar.
2. Type a meaningful name or description for the field.

This can be up to a maximum of 50 characters long and can contain a mixture of letters, numbers or special characters.

**Adding a BNF History Row to the Template**

BNF History rows are very useful for showing specific elements of prescribing history for a patient. You must know what chapter from the British National Formulary you want to display the medicines for.

To add a BNF History Row to the template, use the following steps:

1. On the **Home** tab, select the **Add BNF History Row** () from the **Controls** area of the toolbar.
2. Select the required BNF Chapter from the list.

3. Click the OK button.

Once a BNF Chapter has been selected the Row title will reflect the selection made, but can be edited as with all the other rows by clicking on the text and replacing it with your own description.

Adding an Image Row to the Template

Like the Text row, Image rows are useful to help present titles or other information you want to highlight to the user. For example, you could use the Image row to display a chart or diagram, useful medical images, or to customise your template with the practice’s logo.

To add an Image Row to the template, use the following steps:

1. On the Home tab, select the Add Image Row ( ) from the Controls area of the toolbar.

2. On the Layout tab, select the Change Image button ( ) from the Rows area of the toolbar.

3. Use the Open dialog box to browse to the location of the image file.

4. Select file you want to insert and click Open.
The selected image will then appear inside the template. The Image row placeholder will automatically resize to the image size and resolution.

**Adding a Text Row to the Template**

The purpose of the Text row is to allow the addition of titles, notes, and informational or instructional free text. Against each of the text rows, you can also add small graphics, such as a record bullet (●) or an alert (!) to highlight key pieces of text.

To add a Text row to the template, use the following steps:

1. On the **Home** tab, select the **Add Text Row (A)** from the **Controls** area of the toolbar.
2. Type in the relevant text.

This can be up to a maximum of 50 characters long and can contain a mixture of letters, numbers or special characters.

3. To add a graphic to the text entry, click the **Row Image** drop down button on the **Layout** tab. You can then select the required graphic from the list.

**Adding a URL Row to the Template**

A Universal Resource Locator (URL) is used to access World Wide Web addresses on the internet, or a local file stored on a computer on your network. Adding a URL row to a template provides a hyperlink which the user can click on to open up a web site or document.

To add a URL Row to the template, use the following steps:

1. On the **Home** tab, select the **Add URL Row ( )** from the **Controls** area of the toolbar.
2. Type a name for the URL.

![Image of URL Row dropdown]

BlueBay Medical Systems Website
This can be up to a maximum of 50 characters long and can contain a mixture of letters, numbers or special characters.

3. Click on the Function button (🔗) to assign a URL.

The URL screen will appear allowing you to enter the full URL.

- To link to a website, make sure that you use HTTP:// or HTTPS:// at the start of the URL.
- To link to a document, make sure that you use FILE:// at the start of the URL.

4. When you are happy with the URL that you have entered, click OK.

If you want to link to a file that is stored within your NetworkShare folder so that other users can access it from within the template, you should start your URL with FILE:///%SHAREPATH%/ followed by any subfolders and then the name of the file.

Adding Attachment Rows to the Template
To add an Attachment Row to the template, use the following steps:

1. On the Home tab, select the Add Attachment Row (🔗) from the Controls area of the toolbar.

2. Type a name for the attachment.

This can be up to a maximum of 50 characters long and can contain a mixture of letters, numbers or special characters.

3. Click on the Paperclip Function button (🔗) and point to the document you wish to attach.

The document will then be attached to the template. When then user clicks the link on the template, the document opens.
Adding Read code Group Rows to the Template
The Read code Group Row offers a very simplistic tool for selecting a single Read code from a group of possible Read codes. The appearance of the Read code Group Row will differ, depending on the following:-

- If a single Read code is defined for the group - the row is presented to the user as a checkbox (shown below).

  ![Checkbox Example](image)

- If multiple Read codes are defined for the group - the row is presented to the user as a toggle option group (shown below).

  ![Toggle Example](image)

Unlike the Codeset Row, the major disadvantage of using the Read code Group row is that there is no option to view historical data. Therefore, this tool is only useful where you would need to record a 'one-off' item and not have to view the history.

To add a Read code Group Row, do the following:-

1. On the Home tab, select the Add Read Code Group Row ( ) from the Controls area of the toolbar.

2. The row will already be highlighted so use the keyboard and type a meaningful name or description for the new group.

3. Click on the Codeset button ( ) to assign your Read codes.
The Read code search screen will appear allowing you to search for Read codes, either by keyword or by the actual Read code.

4. Type in a keyword description, or the specific Read code that you want to search for and click **Search**.

![Search screen](image)

*If you know the Read code you want to use you can search for it by entering it into the Search box preceded by a full stop e.g. "68NE" - No Consent - Flu Imm.*

A list of matching Read codes will be displayed in the left-hand column. You can use the More Detail and Less Detail buttons ( << >> ) to browse through the hierarchy for the Read code. If the Read code you want is not displayed in the search list, simply type another keyword or Read code and click Search again.

![Read code search](image)

5. In the left-hand column, click to highlight the Read code you want to use for the data entry field.

6. Click the Add button ( ▶️ ).

The Read code that you select will be added to the column on the right-hand side of the window. You can repeat this process and continue adding as many Read codes as you like to the right-hand column. If you
make a mistake and want to remove a Read code, click to highlight the Read code in the selected list and click the Remove button (isodesign).

If you want to use all of the Read codes within a specific hierarchy, select the top level Read code first and then select the Chapter checkbox for the code. If you want the Read code to be displayed in the primary list make sure the Preferred checkbox for the code is checked, otherwise it will appear only when the More button is clicked.

If you want to only show the history of a Read code, without allowing the Read code to be added then make sure the Apply checkbox is cleared. By default the Apply checkbox is checked, which means that users can view and add in the Read code through the template.

7. When you are happy with the Read codes that you have chosen, click OK.

8. You can also do one or more of the following:

- Set the code to be automatically selected by selecting the Auto Select checkbox.
- Show or hide the Modifiers and Comments fields, by selecting the Show Modifier/Comments checkbox.
- Specify standard free text entries for the Comments field. This can be used to quickly insert common entries, or to help prevent typographical errors and spelling mistakes. To do this, click the Description button (isodesign) and type each of your free text entries separated by a “tilde” character (~). When you are using the template to record information, each entry will appear in the Comments drop down box for that field. When Comments are pre-defined as described above, they replace the standard stored Comments saved in the Comments Button.
Adding a Calculator Row to the Template

To add a Calculator Row to the template, use the following steps:

1. On the Home tab, select the relevant calculator you wish to insert, from the Controls area of the toolbar. The different calculator icons are displayed below.

![Calculator Icons]

Hovering the mouse pointer over an icon gives a description.

2. Type a meaningful name or description for the calculator.

This can be up to a maximum of 50 characters long and can contain a mixture of letters, numbers or special characters. There are several different types of calculator that can be added to the Template:

- ACT Asthma Control Test
- ASSIGN CVD Risk Calculator
- AUDIT Alcohol Calculator
- CAT COPD Assessment Test
- CHADS2 Stroke risk tool
- PHQ9 Depression Assessment Questionnaires
- eGFR Calculator
- FAST Alcohol Screening Tool
- Framingham CHD Risk Calculator
- Framingham CVD Risk Calculator
- GHQ12 General Health Questionnaire
- JBS 2 CVD Risk Calculator
- Mini Mental State Score
- Smoking Pack Years
- PEFR (Peak Flow Rate) Calculator
- RCP3 (The Royal College of Physicians three questions)
- Spirometry
**Inserting a Row into the Template**

When a row is added to a template it is placed below all the other rows on the template. It can then be repositioned (See Changing the Position of Indicator Rows on the Template). The instructions described above are for Adding a row. As an alternative to Adding a row, inserting a row places the row above the currently selected row. In this way it is possible to place a row directly into the correct location. To insert a row, do the following:-

1. Click to highlight the row that you want the new row to be inserted above.
2. Click the expand menu button (⃗️️) on the Controls or Calculator area on the Home tab.
3. From the drop down menu select a row to be inserted from the Insert Control area.
4. Continue to in the same way as described for Adding rows.

**Deleting a Row on the Template**

If you want to remove a row, select the row by clicking on it and then on the toolbar click on the Delete Row button (🗑️) contained within the Rows area of the Layout tab. If only one row is on the template then the Delete button will be greyed out and it will not be possible to delete this row. To remove this final row first add another row and then you will be able to delete it.

**Changing the Position of Rows on the Template**

If you decide that you would like to change the order of the indicators on your template, you can select the relevant row and use the Move row up (↑) and Move row down buttons (↓) on the toolbar.
Saving the Changes to Your New Template

When you are happy with your template, click the Save button (✓) on the toolbar. If you forget to save your template and choose to close the Template Designer screen, the software will prompt you to save the changes anyway.

If you have already modified one of the existing contract templates, you’ll be prompted to overwrite it.

Changing the Status of Templates

When a template is initially created, it will not be available to the whole surgery as it will have the status of “Development”. The purpose of assigning the template a status is to facilitate a development cycle. When the user is satisfied with the template, the status should be set to “Publish”, which essentially enables the template to appear on the BlueBayCT Clinical menu for all users in the practice. This enables the template to be used by the whole practice. Templates can be opened and edited regardless of their status.

Three statuses for templates exist and are described below:-

<table>
<thead>
<tr>
<th>Template Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Develop</td>
<td>When a template has its status set to “Develop”, the template is not available on the BlueBayCT Clinical menu, and can only be opened in Template Designer. This is the default status. It is used when the template is being designed and developed.</td>
</tr>
<tr>
<td>Test</td>
<td>When a template has its status set to “Test”, the template is available to be used only on the computer where the status was set to “Test”. It can be accessed from the BlueBayCT Clinical menu when the patients notes are open. This allows the user who created the template to test it and see how it looks, without releasing it to the whole practice.</td>
</tr>
<tr>
<td>Publish</td>
<td>When a template has its status set to “Publish”, the template is available to be used by all users on all computers in the surgery. It can accessed from the BlueBayCT Clinical menu, when in a patients notes.</td>
</tr>
</tbody>
</table>
Logic Tools
BlueBayCT provides a series of Logic Tools which can help the user to analyse the rules and find out what needs to be done in more complex rules. The Indicator Logic tool is available for all Indicators and provides an in-depth solution for analysing the Ruleset behind the registers and indicators. The Rule Logic and Rule Logic Exception tools help the user by visually displaying what needs to be done in order for the Indicator to be fulfilled and hence cancelled.

Indicator Logic Tool
BlueBayCT has an Indicator Logic Tool which is extremely useful for analysing the rule set logic behind any Register or Indicator. With the help of the Indicator Logic it is possible to understand how a rule works. This is very useful for understanding, for example, why an outstanding Indicator is actually outstanding. In this way it takes the user through the rule set a step at a time allowing an insight to what is going on in the background. This indicator logic can be accessed from the Popup Alert Indicator screen and from within Contract Templates.

To access the Indicator Logic Tool from the Popup Alert Indicator screen, do the following:-

1. Right-click the indicator from the Popup Alert Indicator screen.
2. From the popup menu, choose Indicator Logic.

The Indicator Logic screen is displayed with the currently selected Indicator in the title bar, as below.
The screen is broadly divided into three parts, laid out as tabs. These are the Register, Denominator and Numerator.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register</td>
<td>Explains why the patient is included on the disease register</td>
</tr>
<tr>
<td>Denominator</td>
<td>Explains why the patient is included in the Indicator</td>
</tr>
<tr>
<td>Numerator</td>
<td>Explains if the Indicator has been satisfied</td>
</tr>
</tbody>
</table>

In layman’s terms the register relates directly to whether or not the patient is on that disease register. The Denominator asks the question “Will the patient require this indicator to be done?” and the Numerator asks the question “has this indicator been done?”.

The logical flow goes through the rule one line at a time. If the rule logic for the line is met then the flow progresses on to the next line. A blue Next arrow (🛶) appears in the relevant True or False column to signify this. The logical flow progresses through the rule to a point (normally the end) where it is Selected (✔), unless it is Selected (✔) or Rejected (✘) at some point before.
Rule Logic Tool

The Rule Logic tool is a visual representation of what needs to be fulfilled in order to cancel the more complex indicators. In these cases it is normally more than one Read code that needs to be added. The Rule Logic tool is only available for some of the more complex indicators such as Recording of Dementia tests for DEM4. By using this visual method the user can see at a glance what things need to be done in order for the indicator to be fulfilled. The usual colour coding applies. The Rule Logic tool can be accessed by clicking on the Rule Logic button ( ) alongside the relevant indicator row on a Template, or by clicking on an outstanding indicator to highlight it, and then clicking on the Rule Logic button ( ) on the toolbar.

Shown below is the Rule Logic for DEM4 – Recording of Dementia tests. The top three conditions, shown in green, have been satisfied, but the rule requires all eight conditions to be met, those not fulfilled are shown in black. The Rule Logic screen speaks for itself as the words AND and OR to make it perfectly clear what is expected. The final condition shown at the bottom of the example requires either Glucose Test Recording OR IFCC HbA1c test to be fulfilled, in order that part of the rule to be fulfilled. Read codes can be entered from this screen in the usual way.

![Rule Logic Screen](image)
Where applicable the conditions are divided into groups in a hierarchical manner. By default the groups are collapsed. Buttons on the toolbar at the top of the screen can be used to expand and collapse either the individual groups (\(\text{expand} \quad (\text{open})\)) or all groups (\(\text{all expand} \quad (\text{open all})\)). The individual branches also can be expanded by clicking on the expand (\(\text{open}\)) and collapse (\(\text{closed}\)) icons.

The Rule Logic tool is not available for all indicators and the Rule Logic button will not be available for indicators that do not have the functionality.

**Rule Logic Exception Tool**

The Rule Logic Exception tool works in much the same way as the Rule Logic tool described above. The only difference is the Rule Logic Exception tool is a visual representation of which Exception Read codes need to be applied to the indicator in order to completely except the patient from the Indicator/Category. Exception Read codes can be entered from this screen in the usual way.

The Rule Logic Exception tool is only available to the following indicators. DEM4, EPL9, MH10, SMO5 & SMO7.

The Rule Logic Exception tool is only available to the following indicators. AF6, CKD5, CHD9, CHD14, DM15, EPL9, HF3, STR12.
## Troubleshooting

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution(s)</th>
</tr>
</thead>
</table>
| The Indicators are not popping up when I go into a patient's notes even though BlueBayCT is running as I can see the light bulb icon in the bottom left hand corner of the screen. | The patient may not be on any QOF disease registers. Try a patient who is known to be on a QOF register.  
BlueBayCT auto popup may have been disabled. To reset the position do the following. Right-click on the BlueBayCT light bulb in the bottom right-hand corner of the screen and click on **Reset Position** button located in the top left hand corner of the window, and click **OK**.  
BlueBayCT may have accidentally been moved off the screen. To reset the position do the following. Right-click on the BlueBayCT light bulb in the bottom right-hand corner of the screen and choose **Settings** from the menu. On the **Options** tab clear the tick from **Disable Auto Popup** box, and click **OK**. |
| Download Web Files option is not appearing on the BlueBayCT menu.   | Download Web Files will not be available when User Defined Indicators are disabled. To enable User Defined Indicators do the following. Right-click on the BlueBayCT light bulb in the bottom right-hand corner of the screen and choose **Settings** from the menu. On the **Options** tab clear the tick from **Disable User Defined Indicators** box, and click **OK**. This will not take effect until BlueBayCT is restarted. To restart BlueBayCT right-click on the BlueBayCT light bulb in the bottom right-hand corner of the screen and choose **Help** from the menu. On the Help menu select **Restart**, then click **OK** to agree with the warning. |
| The Popup Alert Indicators box is popping up but certain Indicators are not popping up for some users. | Check the Indicator settings on the **Advanced** tab within the Settings screen. Click on the button labelled **Indicators**, expand the Categories and make sure that the indicators in question have a tick placed alongside them (see **Settings – Advanced tab**).                                                                                             |
| Blank                                                               | Blank                                                                                                                                                                                                                                                                            |